UAN has provided two primary guides for the year end closing process - you should understand the scope and purpose of each before proceeding:

1. The **Year End Checklist** – A form built into the application that provides brief instructions on the **minimum technical requirements** for closing the year in UAN.

2. The **Year End Procedures** booklet – A detailed guide to application tasks for closing the fiscal year. Before beginning, it is essential to understand the organization of this booklet.

   The Year End Procedures booklet will be available after installing the year end update disc: From the Windows desktop, click *UAN Tools → Version Documentation → 2022.1*

   **All UAN users should read the core instructions of the booklet covered on pages 1-37.**

The arrangement of the Year End Procedures booklet is *not* in a standardized ‘one-size-fits-all’ chronological order as one might typically expect. Instead, due to the variety of circumstances in local governments and the flexibility of UAN, the order for completing the activities is adaptable to your particular entity. The core instructions reference the many appendices throughout, but the topics covered in the appendices may or may not be relevant to your entity.

UAN highly recommends that you review the Table of Contents of this booklet for an overview of what will be required for closing the year, particularly to prepare for processing W-2s (if necessary) and to prepare for the new fiscal year.

Also, we recommend reviewing our ‘**Housekeeping**’ videos if you have not done so previously. To view these, click the Accounting or Payroll link below (or enter into your web browser) and then scroll to the Housekeeping section:

   - Accounting: [https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html](https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html)
   - Payroll: [https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html](https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html)
### Year End Frequently Asked Questions

**FAQ #1**
I understand that some year end reporting requires manual type-in or add-in documents created outside of UAN (e.g. Notes to the Annual Financial Statements, Hinkle System demographic and debt data, manually inputted reports, etc.).

**Question:**
When I send the year end audit submission by internet (or disc), is it necessary to include this data in the submission file or am I permitted to send it later?

**Answer:**
All items applicable to the entity are required to be included in your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings. Please see the Important Note on page 23.

**FAQ #2**
Can UAN transmit checkbook-level transactions to OhioCheckbook.gov for 2021?

**Answer:**
Yes, but you must specifically authorize it for each fiscal year after you submit the Annual Financial Reporting file successfully to UAN. Please review page 37.

**FAQ #3**
How do I print the Annual Financial Reports and December 31st YTD reports?

**Answer:**
Refer to step ‘4C - Annual Financial Reports’ in the Year End Procedures starting on page 13. Then refer to ‘Appendix 2: Year End Reports’ starting on page 43.

**FAQ #4**
Where can I find the complete set of Version 2022.1 documentation?

**Answer:**
After installing Version 2022.1, it will be available on your desktop in:

- UAN Tools → Version Documentation → 2022.1

**FAQ #5**
Where can I get instructions and answers to questions about Temporary Mode?

**Answer:**
Refer to Appendix 1: Temporary Mode, starting on page 39 and ‘Step 3: Open Temporary Mode’ starting on page 4 of the Year End Procedures.

**FAQ #6**
Where can I find the Year End Balances Certificate in UAN?

**Answer:**
Refer to ‘Appendix 6: Year End Balances Certificates’ in the Year End Procedures booklet starting on page 103.

**FAQ #7**
Will I be able to print 2014 reports after closing the year 2021?

**Answer:**
You will be unable to retrieve any 2014 reports from UAN after closing fiscal year 2021. If some reports are missing from your entity records, make sure to print and/or save them as PDF files before closing 2021. Refer to page 18 for details.
# TABLE OF CONTENTS

Table of Contents .......................................................................................................................... i

Overview ......................................................................................................................................... 1

Step 1: Install Version 2022.1 ........................................................................................................ 4

Step 2: Computer Date .................................................................................................................... 4

Step 3: Open Temporary Mode ..................................................................................................... 4

Step 4: Year End Checklist .......................................................................................................... 8

- 4A - Batch Transactions ............................................................................................................. 8
- 4B - AFR Demographics & Debt ............................................................................................... 9
- 4C - Annual Financial Reports .................................................................................................. 13

NOTES: Required For All Annual Financial Statement Filing Types ........................................ 13

OCBOA Statement Preparation: Refer To Appendix 7 ............................................................. 14

Regulatory Statements: When To Use The AFR – Fund Utility ............................................. 14

Regulatory Statements: Using the AFR – Fund Utility .............................................................. 15

- 4D - Entity & Fiscal Officer ....................................................................................................... 17
- 4E - Hardware & Mailing .......................................................................................................... 17
- 4F - Next Year FO & Details .................................................................................................... 18

  Acknowledge that 2014 Reports Will Be Removed ................................................................. 18

- 4G - Carryover Purchase Orders .............................................................................................. 19

  Close Purchase Orders ............................................................................................................. 19

  Adjust (Or Reduce) Purchase Orders As Needed ................................................................. 20

  Acknowledge The Effect Of Any Carryover Purchase Orders ................................................ 20

- 4H - Carryover Withholdings ................................................................................................. 20

  Acknowledge The Effect Of Any Carryover Payroll Items .................................................... 21
Step 5: Bank Reconciliation ................................................................. 22

Post The December 31st (Year End) Bank Reconciliation.................. 22

Voiding The Year End Bank Reconciliation (If Needed)....................... 22

Step 6: Computer Date ........................................................................ 22

Finish: Close The Year ....................................................................... 23

Final Review ......................................................................................... 23

Verify W-2 Employee Setup & Withholding Information ..................... 23

Print Year End Reports & Tax Forms Before Closing (Recommended) ... 23

Close The Year .................................................................................. 24

  Acknowledge The Effect Of Any Carryover Purchase Orders .......... 24
  Acknowledge The Effect Of Any Carryover Payroll Items ............... 24
  Select The Finish (Close The Year) Tab ........................................... 24
  Certify The AFR Submission And The Entity’s Responsibilities ...... 24
  Click The Close 2021 button ............................................................ 25

  1 - UAN Backup – 2021 Year End .................................................. 27
  2 - UAN Backup – 2022 Year Begin ................................................ 28
  3 - AFR – AOS Backup For The 2021 Audit Submission ............... 29

Steps After Closing The Fiscal Year ..................................................... 34

  Confirm The UAN Application Is In The New Year ...................... 34
  Confirm Fund Balances Carried Forward ....................................... 34
  Year End Balance Certificate ......................................................... 34

Meeting Annual Reporting Requirements For the Auditor of State ...... 35

  Confirming The Status Of Your Submission .................................... 35
  Publication Requirements ............................................................... 36
  Ohio Checkbook Authorization ...................................................... 37
Print Year End Reports & Tax Forms (If Not Yet Complete) .............................. 37
Other Considerations For The New Year ............................................................. 37

Appendix 1: Temporary Mode ........................................................................... 39

Appendix 2: Year End Reports .......................................................................... 43
Overview ............................................................................................................... 43
AFR Requiring Manual Input ............................................................................... 45
AFR - Notes & Documents ................................................................................... 50
AFR - OCBOA Statements ................................................................................... 55
AFR - Regulatory Statements ............................................................................... 56
December 31st Year-To-Date Reports ................................................................. 58
Payroll Specific Year End Reports ...................................................................... 59
1099 Required – Flag Vendors Ahead of Time .................................................... 59
1099 Forms – Filing Overview & Important Notice ............................................ 60
1099-NEC & 1096 Forms ..................................................................................... 62
  Create a 1099-NEC File for Uploading .................................................... 64
1099-Misc & 1096 Forms ..................................................................................... 65
  Create a 1099-Misc File for Uploading ........................................................ 67
1095 & 1094 Forms .............................................................................................. 68
944 Federal Annual Tax Return............................................................................. 70

Appendix 3: W-2 & W-3 Forms ....................................................................... 71
Preparation & Review ........................................................................................ 71
  Verify W-2 employee setup & withholding information............................. 71
  Confirm entity contact and tax ID information ......................................... 72
  Online or disc submission registration (when applicable) ....................... 72
  Timing: determining when to print W-2 & W-3 forms ............................ 72
Recommended review prior to processing W-2 forms ......................... 73

**Processing W-2 Forms** ................................................................. 74
Add W-2 forms ................................................................. 74
Edit W-2 forms ................................................................. 75
W-2 Editor ................................................................. 79
Print W-2 forms overview .............................................................. 79
Print W-2 forms ................................................................. 81
Print the required ‘Notice to Employee’ .............................................. 82

**Processing W-3 Forms** ................................................................. 83
Print W-3 forms ................................................................. 83
Create W-2 & W-3 Electronic Files (If Required Or preferred)............ 85

Special Note For Clients That Converted To UAN Payroll Mid-Year 2021 .... 90

**Appendix 4: New Year Accounting Procedures** .................................. 91
**Appendix 5: New Year Payroll Procedures** ......................................... 96
**Appendix 6: Year End Balances Certificates** ...................................... 103
**Appendix 7: OCBOA Statement Preparation** ...................................... 107

AFR - Fund Utility .............................................................................. 107
  1 – Fund Mapping ............................................................................. 108
  2 - Governmental Fund Classification Tab ......................................... 109
  3 - OCBOA – Fund Information Tab .................................................. 112
  4 - OCBOA – Revenue Programs Tab ............................................ 116
  5 - OCBOA – Fiduciary Accounts Tab .......................................... 118
  6 - OCBOA – Internal Service Adjustments Tab ............................. 119

AFR - Component Units ...................................................................... 120

**Appendix 8: Recreate AFR – AOS Backup If Needed** ......................... 121
OVERVIEW

Entities using UAN are required to complete various procedures to close 2021 and advance to 2022. This booklet will guide you through those procedures. You complete the actual year-closing process via a “to-do list” incorporated into the application – the Year End Checklist.

**UAN Menu** General → Maintenance → >>Year End → **Year End Checklist**, then click ‘Current Year’

**IMPORTANT**

The Year End Checklist form provides brief instructions on the MINIMUM technical requirements for closing the year in UAN, while this booklet includes details and important considerations.

**All UAN users should read the core instructions of the booklet covered on pages 1-37.**
Some topics covered in the appendices may or may not apply to your entity.

**Example of an incomplete Year End Checklist:**

![Image of Year End Checklist](image)
**USING THE CHECKLIST**

You can access the 2021 year end checklist only while logged into working year 2021. The tab pages operate similarly to the UAN bank reconciliation:

- Click Save and then Close if you need to exit the Year End Checklist. You can save the checklist even when it is incomplete and revisit it later.
- It is recommended (but not essential) to complete the steps in the order listed. You may work on some steps and then revisit them later in the process.
- You can view any of the steps at any time to see what remains left to complete.

Icons used within the checklist:

- **Complete** - This green icon means the step is complete.
- **Incomplete** - This red icon means at least one part of the step is incomplete.
- **Click Tip** - These small blue icons are clickable and will display helpful popup messages related to the area nearby them.
- **Caution!** - This icon applies to steps 4G & 4H. It does not necessarily indicate a problem but is there to draw your attention to important information to consider before closing. *Carefully review the information in these steps!*
- ‘Year End Checklist is NOT complete (red flag)’ means some steps are incomplete. Review the checklist for steps marked ❌ and complete them.
- ‘Year End Checklist is complete (green flag)’ means you have met the minimum requirements to close the year in UAN.

For your convenience, some of the ❌ or ⚠ icons, when clicked on, will open a UAN menu or form applicable to completing the step or sub-step. For example, clicking on the red icon next to step ‘5-Bank Reconciliation’ will open the Bank Reconciliation area.
CHECKLIST SUMMARY

1) UAN version 2022.1 or higher must be installed before the Year End Checklist will be accessible.
2) The UAN computer/calendar date must be in or after December 2021.
3) Temporary Mode must be open (see important notes in that section).
4) Year End Checklist: complete A-H:
   A. All current batch transactions must be posted or deleted.
   B. Select a Demographics & Debt submission type and enter values *(when applicable)*.
   C. Select the desired annual financial report type
      (Complete all steps related to the type selected).
   D. Enter contact information and verify entity information.
   E. Enter state-owned hardware tag numbers and entity addresses.
   F. Enter the new year’s fiscal officer details (if applicable). Read the prior year reports removal notice carefully and mark the acknowledgment statement when you are ready.
   G. Review open purchase orders (if any) and acknowledge their effect on the 2022 budget if you allow them to carry over.
   H. Review unpaid payroll withholdings (if any) and acknowledge their effect on the 2022 budget if you allow them to carry over.
5) Post the bank reconciliation for December 31.
6) The UAN computer/calendar date must be in or after January 2022.

Finish–close the year. The closing process will create three backups:
1. 12/31/2021 UAN backup 2021 year end (to be retained by the entity)
2. 01/01/2022 UAN backup 2022 year begin (to be retained by the entity)
3. AFR- AOS backup (for submission to the Auditor of State)

YEAR END REPORTS

You may print year end reports before or after closing 2021. Read a thorough explanation of year end printing in Appendix 2: Year End Reports starting on page 43.

TIP: USE ‘PAGE-JUMP’ LINKS IN THE PDF VERSION OF THE BOOKLET

UAN incorporates cross-reference links into the Adobe PDF file of the Year End Procedures. This means wherever you see a reference to a page number or section of the booklet, you can click it to jump to that page. This applies to the Table of Contents or any section and page number reference throughout the booklet. For example, click on ‘Appendix 2: Year End Reports’ to jump to that section or click on ‘39’ to jump to page 39 (which is Appendix 1: Temporary Mode).
STEP 1: INSTALL VERSION 2022.1

You must install UAN version 2022.1 (the year end update). Please note that installing it does not automatically open Temporary Mode or advance the application to 2022. If you require any prior version updates, contact UAN Support.

STEP 2: COMPUTER DATE

The UAN computer date (i.e. calendar date) must be in December 2021 or later.

STEP 3: OPEN TEMPORARY MODE

Temporary Mode includes both Accounting and Payroll. You must manually initiate the opening of Temporary Mode, but it will close automatically when you close the fiscal year 2021.

This step will verify that Temporary Mode is open. Temporary Mode allows you to work in both fiscal years 2021 and 2022 before closing the fiscal year 2021. Please note:

- Opening Temporary Mode is required as part of the year end process.
- Working in 2022 before closing 2021, (i.e. using Temporary Mode) is OPTIONAL.

UAN highly recommends using this outstanding feature! A list of its many advantages and details are in ‘Appendix 1: Temporary Mode’, starting on page 39. Please review that appendix before making a choice. For those Fiscal Officers who still choose not to use Temporary Mode, you have the option to complete the rest of the Year End Checklist before completing “Step 3 - Open Temporary Mode”, and then you can immediately close fiscal year 2021.

Report Year

During and after temporary mode, you can produce reports for either 2021 or 2022 regardless of the computer date, and regardless of the work year selected at login. The reporting year (listed at the top left of most report areas) will default to the current work year but can be changed.

OPENING TEMPORARY MODE:

UAN Menu: General ➔ Maintenance ➔ Year End ➔ Open Temporary Mode

When you click Open Temporary Mode, UAN will display a message: Verifying database integrity, please wait... Please be patient while the application takes a few minutes to verify that your financial data is internally consistent. If UAN detects any problems, it will display a message with directions. If it does not detect any errors, the following message will appear:
To continue, click OK and UAN will open a Year End Renaming form.  
*The following picture is an example of the form with sample withholding names.*

In this form, you can rename withholdings not specifically pre-set by UAN for fiscal year 2022.  
**IMPORTANT:** This renaming is **only** possible when opening Temporary Mode - you **cannot** change existing withholding names **at any other time** during the year.  
If you need more time to consider withholding name changes, click Cancel to stop the Temporary Mode opening process. If instead, you are ready to continue, enter the desired changes (**if any!**) under the “Revised Name” column. When you are finished, click Save.
Please be patient: The application will begin creating the data records required for the new year. Processing time for small to mid-size entities could be less than 1 minute – however, the processing time for large entities may be up to 10 minutes or more.

After the processing is complete, a message will display:

![System Message]

Read the message carefully and click OK to continue. UAN will automatically close.

Double-click on the UAN icon to reopen the application. Now that UAN is operating in Temporary Mode, you may select the work year upon login (as seen below):

![User Login]

Notice the buttons above the User Name: “Work Year: 2021 2022”. Each time the User Login form opens in Temporary Mode, the work year will default to 2021. Select the year that you would like to work in and then enter your user name and password. Click OK to log in, and a message will display:
Read the message carefully and click OK to continue. When UAN opens, notice that the top right of the main menu displays a Temporary Mode notification:

The work year that you selected on the User Login form will be displayed, as well as the date upon which 2022 will become unavailable on the login form (if 2021 has not yet been closed).

**Reminder:** Temporary Mode will close automatically when you close the fiscal year 2021.
STEP 4: YEAR END CHECKLIST

IF NEEDED, REOPEN THE YEAR END CHECKLIST:
General → Maintenance → Year End → Year End Checklist, then click Current Year

Complete checklist tabs A-H. Reminder: You do not have to complete these requirements in a particular order or a single sitting.

4A - BATCH TRANSACTIONS

Before closing the year, you must post or delete all 2021 batch transactions. This section lists the number of remaining batch transactions and paths to each batch area beside the transaction type.

Accounting-Only clients – batch EFT, Wages, Withholding Payments, and Withholding Adjustments do not apply to you.

EFT– If the EFT batch is Incomplete and you use the EFT Data Entry method, then you cannot close the year until you mimic the process of creating the batch files. For instructions, open the Payroll EFT Handbook by clicking (or typing in) the following:

https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html

Then scroll down the webpage to the section titled “Payroll Electronic Funds Transfer (EFT)”. There you can open the handbook to review the Payroll EFT section - steps 2 & 4.

Important Reminders
All cash transactions (like posting interest revenue for the primary checking account) and related utility functions needed for the fiscal year should be posted before completing the annual financial report utilities (Step 4C) and before posting the 12/31 bank reconciliation (Step 5), to prevent having to repeat these steps.

Investment and/or secondary checking account balances in UAN should match the corresponding bank statement balances. You must enter all transactions before closing the fiscal year, including interest or fees posted at the bank on December 31.
Submission Type

☐ Submit through UAN with AFR filing (recommended)

Select this type when you wish to submit FINAL Hinkle System information using UAN. This is recommended for the majority of UAN users, as you will NOT be required to use the online Hinkle System after UAN receives the year end submission.

☐ Complete these requirements online (GAAP/FASB)

Only select this type if you will be filing true GAAP statements. This means you will not be using one of the AFR filing options facilitated through UAN (Regulatory or OCBOA – GAAP ‘look-alike’) as your final submission to the Auditor of State, but will prepare true GAAP statements instead. UAN does not recommend this for any other circumstance. When this is selected, you MUST use the online Hinkle System to submit these figures within the deadline set by the Auditor of State’s Office. For guidance contact HinkleSystem@ohioauditor.gov An override password is necessary to close the year with this submission type. If you intend to submit true GAAP statements, send an email to HinkleSystem@ohioauditor.gov for the override password.

Additional Audit Reports

☐ Include additional reports (UAN-generated)

Audit staff sometimes request various reports from the fiscal officer for their review before a formal audit. By selecting this option, UAN will automatically send these reports when submitting the annual financial reports. Click the blue question mark for more information.

☐ Do not include additional reports

**Continue to the next page**
WHEN USING THE ‘AFR DEMOGRAPHICS & DEBT’ LIST GRID

Input applicable items in the list with values/amounts ‘as of’ 12/31/2021.

SPECIAL DISTRICTS ONLY:
The grid list is intentionally blank since special districts, (e.g. fire, water & sewer, park, etc.) are required to choose a submission type, but are not required to enter additional data.

TOWNSHIPS, VILLAGES, AND LIBRARIES:
To meet the minimum technical requirement for completion of this section, townships and villages must enter a value in the ‘Population’ field while libraries must enter the ‘Number of Patrons’.

You are required to enter all values applicable to the entity here for your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings.

Many values may not be available until after the end of the year. UAN recommends gathering information such as population, tax rate, assessed property tax valuation and debt (only the items applicable to your entity) as soon as possible so you are prepared to enter those values in UAN. By using Temporary Mode, you might gain some extra time to complete these items before closing the fiscal year within the deadline.

Please Note:
• Debt information must not include any premiums/discounts on debt insurance, nor any gains/losses on debt refunding or long-term compensated absences, claims, or pension liabilities. For guidance, contact the AOS Center for Audit Excellence at 1-800-282-0370.

• If you wish to verify the ‘Calculated’ amounts that automatically populate the grid, view two reports in the UAN menu: Accounting → Reports and Statements. Review the ‘Final Appropriation Total’ for all funds on the ‘Appropriation Status’ report and the ‘Unencumbered Fund Balance’ for the General fund on the ‘Fund Summary’ report.

For your convenience, the AFR Demographics & Debt items applicable to each entity type are on the two pages that follow (as they will appear on the Year End Checklist 4B tab).
<table>
<thead>
<tr>
<th>Description</th>
<th>Calculated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population</td>
<td></td>
</tr>
<tr>
<td>Total Annual Final Appropriations for All Funds for the Reporting Year</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation – Inside Millage</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation – Outside (Voted) Millage</td>
<td></td>
</tr>
<tr>
<td>Total Assessed Property Tax Valuation</td>
<td></td>
</tr>
<tr>
<td>Unrestricted General Fund Carryover Cash Balance at Year End</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - General Obligation Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Special Assessment Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Notes Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Loans Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Capital Leases</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Revenue Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Miscellaneous Long Term Bonds</td>
<td></td>
</tr>
</tbody>
</table>

Continue to the next page for the Village and Library tables.
## VILLAGES

<table>
<thead>
<tr>
<th>Description</th>
<th>Calculation Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population</td>
<td></td>
</tr>
<tr>
<td>Total Annual Final Appropriations for All Funds for the Reporting Year</td>
<td>(Calculated)</td>
</tr>
<tr>
<td>Average Number of Utility Customers</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation – Inside Millage</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation – Outside (Voted) Millage</td>
<td></td>
</tr>
<tr>
<td>Total Assessed Property Tax Valuation</td>
<td></td>
</tr>
<tr>
<td>Unrestricted General Fund Carryover Cash Balance at Year End</td>
<td>(Calculated)</td>
</tr>
<tr>
<td>Governmental Funds - General Obligation Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Special Assessment Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Notes Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Loans Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Capital Leases</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Revenue Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Miscellaneous Long Term Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - General Obligation Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Special Assessment Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Notes Payable</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Loans Payable</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Capital Leases</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Revenue Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Miscellaneous Long Term Bonds</td>
<td></td>
</tr>
</tbody>
</table>

## LIBRARIES

<table>
<thead>
<tr>
<th>Description</th>
<th>Calculation Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Patrons</td>
<td></td>
</tr>
<tr>
<td>Yearly Circulation</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation – Inside Millage (if applicable)</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation – Outside (Voted) Millage (if applicable)</td>
<td></td>
</tr>
<tr>
<td>Total Assessed Property Tax Valuation (if applicable)</td>
<td></td>
</tr>
<tr>
<td>Unrestricted General Fund Carryover Cash Balance at Year End</td>
<td>(Calculated)</td>
</tr>
<tr>
<td>Governmental Funds - General Obligation Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Notes Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Loans Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Capital Leases</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Revenue Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Miscellaneous Long Term Bonds</td>
<td></td>
</tr>
</tbody>
</table>
Select the Annual Financial Report (AFR) Filing Type that you would like to include with the audit submission when the year is closed:

🎯 OCBOA Modified Cash Basis
Select this option if you will be filing GAAP ‘look-alike’ statements and the entity has at least one non-pooled investment.

🎯 OCBOA Cash Basis
Select this option if you will be filing GAAP ‘look-alike’ statements’ and the entity has zero non-pooled investments.

🎯 Regulatory
Select this option if you elect not to present GAAP ‘look-alike’ statements.

NOTES: REQUIRED FOR ALL ANNUAL FINANCIAL STATEMENT FILING TYPES

The Notes & Documents section (on the right side of the page of Step 4C) will list the number of files currently added into UAN. UAN does not generate certain AFR documents (whether required or optional) when there is nothing in the day-to-day software activities that would produce them. Instead, you can prepare these documents outside of UAN and then add them to the application.

All entities are required to add-in the Notes to the Annual Financial Statements. You can include other documents when audit requires or requests them and/or other supporting documents that you choose to submit. Step 4C and the Notes & Documents section’s status will display incomplete ☠ until one or more files are included under General → Reports & Statements → Year End → AFR – Notes & Documents, Year 2021. **For more information about Notes, review the instructions in Appendix 2: Year End Reports starting on page 50.**

Instructions specific to **OCBOA** or **Regulatory** filing continue on the next page.
OCBOA STATEMENT PREPARATION: REFER TO APPENDIX 7

The Auditor of State recommends but does not require, submission of GAAP ‘look-alike’ statements – referred to as OCBOA statements (Other Comprehensive Basis of Accounting).

Skip to Appendix 7: OCBOA Statement Preparation starting on page 107 when you are filing these types of statements.
Upon completing, turn to page 17 to continue onto Step 4D - Entity & Fiscal Officer.

REGULATORY STATEMENTS: WHEN TO USE THE AFR – FUND UTILITY

In recent years, the majority of UAN clients have chosen to file regulatory statements. It is easy to see on the Year End Checklist that when choosing ‘Regulatory’ that most of the minimum requirements to close the year will disappear (except for ‘Notes & Documents’). However, the Auditor of State may still require a few report modifications that UAN cannot automatically detect. When applicable, these are completed in the AFR Fund Utility UAN Menu: General → Reports & Statements → Year End → AFR – Fund Utility

The AFR-Fund Utility is ONLY necessary for Regulatory Filing when:

- The entity has at least one custodial fund type.
- When it is necessary to ‘map’ at least one fund.

Custodial Funds
If your entity has any custodial type funds, you must identify whether those funds should report as part of an External Investment Pool or Other Custodial on Regulatory AFR Statements. To view the two statements affected by this go to UAN Menu: General → Reports & Statements → Year End → AFR – Regulatory Statements, select the year and then the (abbreviated) statement name:

- Combining Statement – Proprietary and Fiduciary
- Combined Statement – Proprietary and Fiduciary

Fund mapping:
When a fund is ‘mapped to’ another fund, it means the current fund’s balance will be considered part of the selected fund’s balance for the purpose of annual financial statements. Mapping is an option for miscategorized or ancillary (subsidiary) funds only. By default, funds are not mapped to other funds. Most UAN entities will have no need to map any of their funds. Clicking ‘Map To’ in the utility requires you to pick another fund that the current fund will be ‘mapped to’. When a fund is mapped to another fund:
• The cash balance of that fund will be included in the ‘Map To’ fund for the purpose of annual financial statements only.
• The mapped fund takes on all characteristics of the fund it is mapped to.
• If the characteristics of a fund that it is mapped to are changed, the mapped fund is updated to match.
• The mapping information will not carry over to the next year. The proper fund will need to be added once the entity is in the new year.
• You can map several funds to one fund, but a fund cannot be mapped to a fund that is also mapped to another fund.
• The General Fund is not allowed to be mapped to another fund.
• You cannot map Governmental or Proprietary type funds to Fiduciary type funds (Fiduciary to Fiduciary is permitted when applicable).

A typical example is if the fiscal officer determines money was miscategorized in 2021, but it will not be corrected until the beginning of 2022. Mapping will allow the fund to be categorized correctly for the purposes of the 2021 annual financial reports. After 2021 is closed, the balance of the fund should be moved to the fund to which it was mapped. Similarly, if this option is used to map a fund to a completely new fund, the original fund balance should be moved to the new fund after closing the year. Another example is the possibility that an Unclaimed Monies fund balance might need to be reported in the fund that will eventually receive the money (usually the General fund). This can be achieved by mapping.

For questions regarding whether or not a fund should be mapped to another, please contact Local Government Services at ContactLGS@ohioauditor.gov or 800-345-2519.

**REGULATORY STATEMENTS: USING THE AFR – FUND UTILITY**

*UAN Menu:* General → Reports & Statements → Year End → AFR – Fund Utility

All funds – whether active or inactive – will be on the list. Checkmark the funds you would like to edit and click Edit.

Click Regulatory and the ‘Edit AFR – Fund Utility’ form will open. When editing multiple funds at the same time, use the navigation arrows in the bottom left corner of the form.
For example, six funds were selected here: ![Image](https://example.com/image.png). Click the arrows to advance back and forth between funds or move to the first or the last fund selected.

**Custodial Funds**
Identify how the fund assets will be reported on Regulatory Statements. This setting will only display for custodial funds:

![Custodial Funds](https://example.com/custodial-funds.png)

**Mapping:**
Mapping should only be done when necessary. To map a fund, click the ‘Map To’ button and select the fund number that the current fund’s balance will be considered part of for the purpose of annual financial statements. An example of fund mapping is in the image below:

![Fund Mapping](https://example.com/fund-mapping.png)

**Mapping Report:**
If you map a fund in the AFR – Fund Utility, you can view the impact it has on the fund it is ‘mapped to’ with the Mapping report. **Note:** This report is under OCBOA reports, but you can print it even if you file Regulatory. **UAN Menu:** General ➔ Reports & Statements ➔ Year End ➔ AFR – OCBOA Statements, then select Mapping and the year from the menus.

**Reset button**
Located below the list of funds, the reset button will reset the funds you select to the UAN defaults.
4D - ENTITY & FISCAL OFFICER

If you closed the Year End Checklist while completing the AFR – Fund Utility, reopen it:

**UAN Menu**: General ➔ Maintenance ➔ Year End ➔ **Year End Checklist**, click Current Year

Click tab 4D to enter your contact information and verify the fiscal officer's name and entity information. If you need to edit the fiscal officer name or entity tax IDs: **UAN Menu**: General ➔ Maintenance ➔ Entity Setup

4E - HARDWARE & MAILING

**UAN Hardware Tags**
Confirm or correct tag numbers from the state-owned hardware so that UAN can maintain an annual accounting of inventory. The form lists the numbers from UAN records. Click the icons for tag location descriptions and photos to verify these numbers are the same on the actual hardware tags.

**If UAN records are correct**, then mark the checkboxes ‘✔ My auditor tag matches UAN records’ and ‘✔ My computer tag matches UAN records’.

**If UAN records are incorrect**, enter the correct tag number in the input field instead and leave the checkbox clear ‘☐’. Note: During the closing process, UAN will check to confirm the accurate tag number format of any corrections that are input.

**UAN Hardware Address:**
Enter your hardware shipping address. This must be a physical location. **Do not enter a PO Box**.

**Mailing Address:**
Enter your mailing address – the location UAN should mail physical correspondence to you.
Select 2022’s fiscal officer status and enter details if there are any known changes.

**New Year’s Fiscal Officer:**
- ☐ Same as current fiscal officer
  - Select if the current fiscal officer will be the new year’s fiscal officer.
- ☐ Newly elected/appointed fiscal officer
  - Select if the fiscal officer in the new year is newly elected or newly appointed. Then fill in the ‘as of’ date, name, address, phone, and email address.

### ACKNOWLEDGE THAT 2014 REPORTS WILL BE REMOVED

Following the AOS retention policy of maintaining only seven years of prior year reporting in the application, UAN will automatically remove all reports older than seven years. When you are ready, mark the checkbox:

☑️ I have read and understand that upon closing year 2021, the year 2014 will be removed from the application.’

**You will be unable to retrieve any 2014 reports from UAN after closing fiscal year 2021.**

If some reports are missing from your entity archives (non-UAN application records), make sure to print and/or save them as PDF files before closing 2021. ‘Appendix 2: Year End Reports’ includes suggestions for 2021 ‘December 31st Year-To-Date Reports’ and ‘Payroll Specific Year End Reports’ that you can use as a guide for which reports to archive for 2014 in addition to the AFR statements that apply to your entity.

### Retrieving prior year reports to Print or Save to PDF

To access a prior year, open the report area, and click the ‘Year’ menu in the upper left corner. Select the fiscal year of the report you would like to print or PDF, as seen in the following example:

![Payment Reports](image)

To save a prior year report as a PDF file, follow all of the steps to print except instead of clicking Print, click **Save PDF** located in the lower right corner of the report area. This will open a ‘Save As’ window, enabling you to save the file in any directory (i.e. folder). The default directory is C:\_UAN_Efiles.
This section lists all purchase orders that are currently open. This is useful information to review so that you can close any that are no longer necessary, or reduce any with balances in excess of what will be necessary for 2022 payments.

**Reminder**: There are four purchase order types: PO Regular, PO Then & Now, BC Regular, and BC Super. *The instructions below refer to all types as 'purchase orders'.*

### CLOSE PURCHASE ORDERS

Purchase orders that have a zero available balance will automatically close when you close the year. **All others will carry forward if you do not close them.** Be sure to post all 2021 payments against them before closing. If necessary, you may carry any purchase order into the new year.

**UAN Menu**: Accounting → Utilities → Purchase Order Utility. A five-minute video demonstration is available on the UAN website. To view, click or enter the following link and scroll to the ‘Housekeeping’ and then ‘Purchase Order’ section.

https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html

### IMPORTANT

After a purchase order is carried over to the fiscal year 2022 (i.e. *it is left open when you close the year 2021*), it cannot be reduced, and closing it in 2022 will **not** increase the unencumbered balance available for appropriations in 2022. See the explanation below for details.

Carryover purchase orders reduce the unencumbered balances presented to the county auditor for purposes of calculating total resources available for appropriation. Therefore, closing unused purchase orders after they carry over into the next year will NOT increase the total resources available for appropriation until the fiscal year AFTER they are closed.

This rule prevents claiming inflated encumbrance amounts when filing for the Official Certificate of Estimate Resources. To avoid mistakenly restricting the entity's 2022 resources for the entire fiscal year, you should only allow encumbrances sufficient for meeting true outstanding obligations to carry over across years.
ADJUST (OR REDUCE) PURCHASE ORDERS AS NEEDED

Reduce purchase orders as needed. To avoid unnecessary carryover encumbrances, you can reduce purchase orders with an available balance in excess of what was or will be necessary for 2022.

**UAN Menu**: Accounting → Utilities → Purchase Order Utility, a five-minute video demonstration is available on the UAN website. To view, click or enter the following link and scroll to the ‘Housekeeping’ and then ‘Purchase Order’ section. 
https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html

ACKNOWLEDGE THE EFFECT OF ANY CARRYOVER PURCHASE ORDERS

After thoroughly reviewing the list and adjusting and/or closing purchases (if necessary), and when you are ready to close the year, then mark the checkbox: “Open Purchase Orders: I acknowledge the effect that any carryover items will have on the 2022 budget.” This will change the tab icon from incomplete to complete.

The checkbox resets to unmarked whenever you close the form because later activity could change the carryover encumbrance. So you can wait until you are about to close 2021 to mark it.

4H - CARRYOVER WITHHOLDINGS

Current unpaid withholdings display in this section for your review. *This step does not apply to Accounting-Only UAN clients.* It is useful information to review so that you can:

- Confirm unpaid withholdings that **should carry over** for payment in 2022.
- Identify unpaid withholdings that **you should pay** in 2021.
- Identify unpaid withholdings that **you should clear** from the Payroll software in 2021 because they have been *(or will be)* paid through the Accounting software.

All withholdings left unpaid when closing 2021 will carry over to pay in 2022. Resources available for appropriations in 2022 will be reduced by the carryover unpaid employee and fringe benefit withholdings.
IMPORTANT

Clearing an unpaid withholding after it is carried over to fiscal year 2022 will NOT increase the new year’s available resources (just like Purchase Orders, discussed above).

Carryover payroll encumbrances (unpaid employee share or fringe benefit withholdings, if applicable) reduce the unencumbered balances presented to the county auditor for purposes of calculating total resources available for appropriation. Therefore, clearing unpaid withholdings after they carry over into the next year will NOT increase the total resources available for appropriation until the fiscal year AFTER they are closed.

This rule prevents claiming inflated encumbrance amounts when filing for the Official Certificate of Estimate Resources. To avoid mistakenly restricting the entity's 2022 resources for the entire fiscal year, you should only allow payroll encumbrances sufficient for meeting true outstanding obligations to carry over across years.

Note: Carryover balances calculate when closing 2021, not when opening Temporary Mode. You CAN still pay or clear carryover withholdings during Temporary Mode.

If you have identified items that you think probably should be paid or cleared in 2021, you should investigate further so that you can complete those steps (if necessary) before you close 2021. UAN recommends reviewing the short video ‘Evaluate Unpaid Withholdings’. Click or enter the link below and scroll to ‘Housekeeping’.

https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html

ACKNOWLEDGE THE EFFECT OF ANY CARRYOVER PAYROLL ITEMS

After thoroughly reviewing the list and clearing any unpaid withholdings that you determine should not carry over (if applicable), when you are ready to close the year, then mark the checkbox: “Unpaid Withholdings: ☑ I acknowledge the effect that any carryover items will have on the 2022 budget.” This will change the tab icon from ✗ incomplete to ✔ complete.

The checkbox resets to unmarked whenever you close the form because later activity could change the carryover encumbrance. So you can wait until you are about to close 2021 to mark it.
STEP 5: BANK RECONCILIATION

Important Reminders
You cannot forward-date bank reconciliations, thus you cannot add the December 31 bank reconciliation until the computer date (calendar date) is on or after 12/31/2021. Please review the Important Reminders listed on page 8 of this booklet before posting this bank reconciliation.

POST THE DECEMBER 31ST (YEAR END) BANK RECONCILIATION

You must post the December 31 (year-end) bank reconciliation before closing the year. The steps to add and post it are just like any other bank reconciliation.

_UAN Menu_: Accounting → Transactions → Bank Reconciliation, then click ‘Need Help’ or FAQs for more information.

IMPORTANT: you must date the year end bank reconciliation ‘as of’ 12/31.

VOIDING THE YEAR END BANK RECONCILIATION (IF NEEDED)

If the December 31 bank reconciliation is in batch (saved but not posted), it is available to edit or delete like any other bank reconciliation in Accounting → Transactions → Bank Reconciliation.

When necessary, you can void a posted December 31 bank reconciliation. Voiding the bank reconciliation changes the status of all items marked cleared and/or voided on that reconciliation back to ‘outstanding’ and deletes the reconciliation.

_UAN Menu_: Accounting → Utilities → Bank Reconciliation Utility
Place a checkmark beside the 12/31 bank reconciliation and click Void. A voided bank reconciliation will no longer appear in the list.

STEP 6: COMPUTER DATE

The computer/calendar date must be on January 1, 2022, or later before you can close 2021.
FINISH: CLOSE THE YEAR

FINAL REVIEW

Review all tabs in the year end checklist for accuracy and address any that have the incomplete status icon 🚫. After you have completed the minimum technical requirements to close the year, the Finish flag icon ✅ will change from red to green indicating the checklist is complete.

VERIFY W-2 EMPLOYEE SETUP & WITHHOLDING INFORMATION

Edits to the following employee and withholding areas will not automatically update 2021 W-2 forms if done in work year 2022 and more time-consuming manual edits will be necessary.

- Employee names, social security numbers, and addresses.
- Local tax abbreviations and school district numbers

Save time by verifying and entering any needed corrections before closing fiscal year 2021. See instructions on the first two pages of Appendix 3: W-2 & W-3 Forms starting on page 71.

PRINT YEAR END REPORTS & TAX FORMS BEFORE CLOSING (RECOMMENDED)

You may print year end reports before or after closing the year. Detailed instructions are in Appendix 2: Year End Reports starting on page 43.

Important: Some year-end reporting requires manual input into UAN or external add-in documents. You cannot submit separate document files. You must complete the manual input and add-in steps that apply to your entity, for UAN to compress it into the AFR-AOS Backup – which is a single file created during the year-end closing that you choose to submit automatically by internet or disc for mailing. You are required to complete all steps prior to the final year-end audit submission (AFR-AOS Backup) and UAN must receive it before the deadline set by the Auditor of State - financial penalties may be assessed for late filings.

For more information, review the following:
- AFR Requiring Manual Input (page 45)
- AFR - Notes & Documents (page 50)
- 4B - AFR Demographics & Debt (page 9) i.e. the Hinkle System data entry

Recommendation: By using Temporary Mode, you might gain some extra time to complete the items above before closing the fiscal year.
CLOSE THE YEAR

If you exited the Year End Checklist while completing the requirements above, reopen it:
UAN Menu: General → Maintenance → Year End → Year End Checklist
Click Current Year

ACKNOWLEDGE THE EFFECT OF ANY CARRYOVER PURCHASE ORDERS

Select 4G-Carryover Purchase Orders. Review the list one more time and when you are ready to close the year, mark the checkbox: “Open Purchase Orders: ✔ I acknowledge the effect that any carryover items will have on the 2022 budget.” This will change the tab icon from ☠ incomplete to ✔ complete.

ACKNOWLEDGE THE EFFECT OF ANY CARRYOVER PAYROLL ITEMS

Select 4H-Carryover Withholdings. Review the list one more time and if you are ready, mark the checkbox: “Unpaid Withholdings: ✔ I acknowledge the effect that any carryover items will have on the 2022 budget.” This will change the tab icon from ☠ incomplete to ✔ complete.

SELECT THE FINISH (CLOSE THE YEAR) TAB

The flag should be ✔ green, meaning the minimum technical requirements are complete and the ‘Close 2021’ button should be accessible (but do not click it yet. Continue with the instructions).
Note: If the button is shaded gray (i.e. if you click it, nothing happens), that means that some steps are incomplete. Review the tabs with the incomplete status icon ☠. After addressing these issues, the Finish flag icon will change from red to green.

CERTIFY THE AFR SUBMISSION AND THE ENTITY’S RESPONSIBILITIES

Carefully read the Finish (Close the Year) tab page. When you are ready to certify the accuracy and completeness of the AFR submission and the entity’s responsibilities, checkmark the acknowledgment statement. ✔ I affirm …
You will be unable to retrieve any 2014 reports from UAN after closing fiscal year 2021.
Final notice: If some reports are missing from your entity archives (non-UAN application records),
make sure to print and/or save them as PDF files before closing 2021. See page 18 for details.

Prepare for extra processing time to remove the prior years
Fiscal officers with UAN experience will notice the processing time to close the year will be longer
than in recent years. This is due to the extra time necessary to delete 2014 data. For example, at
entities with a large volume of transaction history, the closing may require up to 30-45 minutes.

Click **Close 2021** to begin the process.
After a moment of processing (verifying database integrity), you should receive this message:

Click OK if you wish to continue and you will receive this message:
Click OK if you wish to continue. If UAN does not detect hardware tag errors, the application will guide you through creating backups and you can skip to the directions starting on page 27.

**Potential error messages:** UAN confirms whether the Auditor of State tag number entered in ‘Step 4E – Hardware & Mailing’ is valid. If it is not valid, the following message will open:

![System Message]

Click OK. Now UAN will check the Computer tag number entered in ‘Step 4E – Hardware & Mailing’. If it appears to be invalid, the following message will open:

![System Message]

Follow the directions in the message. If needed, correct the Auditor and/or Computer tag numbers entered on tab 4E - Hardware & Mailing. Then click the Finish (Close The Year) tab again and click ‘Close 2021’ to repeat the above steps to close the year.

After you resolve hardware tab errors (if needed), the application will guide you through creating three backups described in the directions starting on page 27.
The entire year’s activity must be backed-up before fiscal year 2021 will close. After following the steps on the previous page, a message will appear. Read the message carefully and click OK. The first of the three backup forms will open ‘UAN Backup – Year End 2021 – Backup 1 of 3’.

This form operates exactly as any other UAN Backup required throughout the year. Choose the backup destination, insert the desired media (CD, DVD, flash drive, network drive, or other), and click Start. UAN strongly recommends that you use a blank CD or DVD and that you do not reuse it later for any other purpose.

**Reminder:** If needed, detailed instructions for UAN Backups are located in the Accounting & General Manual under the General → Maintenance → Backup section.

When this backup is complete, the fiscal year 2021 closes in UAN and a message will open with information about the next backup. If the backup destination was a CD or DVD, then you should immediately remove the disc and label it so that it is clearly distinguished from other discs.

*Suggested label:*

2021 Year End Backup  
Your Entity Name  
Your County Name  
Your UAN Entity ID Number

**Do NOT send this backup to UAN as your 2021 audit submission.**  
This backup is not valid for audit submission (i.e. AFR – AOS backup) and does not satisfy your legal filing deadline! Instead, the entity should retain it and keep it separate from your backup rotation cycle. The backup media should be stored in a secure place, preferably off-site.
As noted on the previous page, after the first backup is complete a message will open with instructions for completing the second backup. Read the message carefully and click OK. The second of the three backup forms will open ‘**UAN Backup – Year Begin 2022 – Backup 2 of 3**’.

This form also operates exactly like any other UAN Backup. Choose the backup destination, insert the desired media (CD, DVD, flash drive, network drive, or other), and click Start.

When the backup is complete, the backup form will close and a message will open with information about the next backup. If the backup destination was CD or DVD, then you should immediately remove the disc and label it so that it is clearly distinguished from other discs.

*Suggested label:*

**2022 Year Begin Backup**
Your Entity Name
Your County Name
Your UAN Entity ID Number

**Do NOT send this backup to UAN as your 2021 audit submission.**
This backup is not valid for audit submission (i.e. AFR – AOS backup) and does not satisfy your legal filing deadline!
As noted on the previous page, after the second backup is complete a message will open with instructions for completing the third backup. Read the message carefully and click OK. The last of the three backup forms will open ‘AFR – AOS Backup – Year End 2021 – Backup 3 of 3’.

You must choose a backup destination, either Internet Submission (instructions start below) or Postal Submission (instructions start on page 32). UAN recommends internet submission for entities that have access to a good high-speed internet connection.

**INTERNET SUBMISSION**

Make sure the computer has an internet connection. Select ‘Internet Submission – Active Connection Required.’ Then click Start and the backup form will begin the process. After it prepares the backup for internet upload, a file-submission progress message will open as follows:

UAN will automatically upload the file to the AOS Hinkle System i.e. there is no need to login to a website or search for a file for upload. Please be patient. The amount of time it will take to upload the file can vary significantly depending on your internet speed and the size of the file. Entities with high-speed internet service can expect uploading the file to take 1-5 minutes for a file under 50MB, 5-10 minutes for 50-100MB files, or 10-30 minutes for files over 100MB. For entities that use the very slow ‘dial-up’ internet (i.e. not a high-speed internet service), UAN recommends mailing the file on a disc (see option #2).

Please note: When you browse websites, you are “downloading” information, but when you transmit a file off the computer to AOS, you are “uploading” information. Internet upload speeds are typically 1/10th as fast as download speeds, so even though you may have a “high-speed internet” service that does not necessarily mean you have “high-speed uploads” as well.

When the upload is complete, the following message will open:
Carefully read the message and click OK.

Note: If the backup fails to upload, a status message will appear in the backup form “Backup Failed. Please try again or contact UAN for assistance.” Confirm or establish an internet connection and click Start to try again. If the upload continues to fail, you can either change the type to ‘Postal Submission’ to create a disc for mailing or close the form and try again after establishing a good internet connection. When closing the form after a failed attempt, the following will open:

A ‘2021 is now closed’ confirmation message will display:
Carefully read the message and click OK – the application will log out.

Be sure to read “Meeting Annual Reporting Requirements for the Auditor of State” starting on page 35 concerning the deadline requirements and steps to confirm the status of your submission. However, you should first confirm that the UAN application is operating in the new year and that the correct fund balances have carried forward – continue to page 34 for details.

* If you are choosing to submit by mail, instructions for Postal Submission begin on the next page*
**POSTAL SUBMISSION**

If the UAN computer is a laptop, connect the external CD/DVD drive and insert a blank disc in the CD/DVD tray.

Note: Windows may automatically open a File Explorer window – please close the window. Alternatively, Windows may prompt with a message to choose what to do with the disc drive – similar to the message below.

Select ‘Postal Submission – CD or DVD’

If needed, click the Browse button to open a ‘DriveSelect’ form that lists the current disc drive letter that Windows has assigned to the disc drive. Select the drive and click OK to close the DriveSelect form.

Click Start to begin the backup process. When the backup completes, a disc writing progress message will open as follows:

When it finishes, the following message will open and the disc will eject.
Immediately label the AFR – AOS Backup disc for audit submission as follows:

2021 AFR
Your Entity Name
Your County Name
Your UAN Entity ID 4-digit Number

Please mail the disc to:
Auditor of State of Ohio
Uniform Accounting Network
88 E. Broad St.
Columbus, Ohio 43215

A ‘2021 is now closed’ confirmation message will display:
Carefully read the message and click OK – the application will log out.

Be sure to read “Meeting Annual Reporting Requirements for the Auditor of State” starting on page 35 concerning the deadline requirements and steps to confirm the status of your submission. However, you should first confirm that the UAN application is operating in the new year and that the correct fund balances have carried forward – continue to page 34 for details.

**STEPS AFTER CLOSING THE FISCAL YEAR**

You have completed the year-end closing process, but do not forget these important steps.

**CONFIRM THE UAN APPLICATION IS IN THE NEW YEAR**

Log into UAN – the Login form should no longer have a ‘Work Year” option. Confirm that there is no longer a Temporary Mode notification in the top right corner and that Year: 2022 displays in the status bar in the bottom right corner of UAN (to the left of the current date).

If 2021 displays in the status bar instead of 2022, then you have not successfully closed the year. Carefully repeat the closing process outlined in this booklet, starting on page 24. For further assistance, contact UAN Support at uan_support@ohioauditor.gov or 1-800-833-8261.

**CONFIRM FUND BALANCES CARRIED FORWARD**

Print the Cash Summary by Fund for December 2021 and for January 2022 to confirm the fund balances carried forward correctly. Compare the ‘Fund Balance 1/1/2022’ column on January 2022’s report to the ‘Fund Balance 12/31/2021’ column on December 2021’s report.

**UAN Menu:** Accounting ➔ Reports & Statements ➔ Fund Reports, select Cash Summary by Fund, the year and month.

**YEAR END BALANCE CERTIFICATE**

You can use the Budget software provided by UAN to create the Year End Balances Certificate for submission to the county auditor – see page 103 for details. Using UAN Budget to prepare this certificate is optional.
Each local government is required to submit their Annual Financial Report to the Auditor of State within **sixty (60) days of the end of the fiscal year**. Meeting this requirement for UAN members occurs when the 2021 AFR internet upload (or disc) containing the end of year filing data of the government is received by UAN.

**Reminder**: the final 2021 AFR-AOS Backup internet (or disc) submission must include *all that is applicable for your entity*: Hinkle System data entry for Demographics & Debt, other manually input reports, and compressed add-in documents. See the important note on page 23 for details. Financial penalties may be assessed for late filings.

---

**CONFIRMING THE STATUS OF YOUR SUBMISSION**

Whether your submission was by internet or mail, you should confirm the filing status on the Hinkle System through the Auditor of State's Customer eServices website. Please allow 5 business days with postal or 3 business days with the internet for the Hinkle System to process the file. For your convenience, there are two menu shortcuts built into the application that will take you directly to the eServices website. Connect your computer to the internet (if needed), then click one of the menu shortcuts listed:

**UAN Menu**: General → Maintenance → Year End → AFR – Filing Status **OR**
General → Reports & Statements → Year End → AFR – Filing Status

Either option will open the AOS eServices ‘Customer Log-in’ page. To access the website from a different computer, connect to the internet and type the following into the web browser:

https://eservices.ohioauditor.gov

The Customer Number that you need to enter is the same as the Auditor of State (AOS) account number located on any AOS invoice for your entity. It is five characters long and follows the format: two numbers, one letter, and two numbers. The Customer Email Address that you need to enter is the email address your entity has on file with AOS Fiscal Department. If you have trouble logging into your eServices account, please send an email to eServices@OhioAuditor.gov

After logging into the eServices account, the following steps will allow you to view the annual financial statements and notes. Reminder: this is for viewing only; your entity does not complete any additional steps on the website to file with the Hinkle System.
Step 1: On the Eservices home screen, select the ‘Hinkle System’.

Step 2: On the Hinkle System page, there will be a table. Within the table are the year end filings that have been submitted to the Hinkle System. To review the 2021 year end filing, select 2021 in the blue font. The Financial Data Viewer page will display.

Step 3: On the Financial Data Viewer page, select ‘View All Details’. The Filing Details page will display.

Step 4: On the Filing Details page, select the PDF document icon located to the right of ‘Uploaded Document’ to open it. Note: If the document does not open right away, look for a message on the screen asking if you want to Open, Save, or Cancel the document. Click Open to display the document.

Step 5: The PDF document will contain annual financial report statements listed first, followed by the notes to the financial statements at the end. Scroll to the end of the document to confirm that all of the notes pages that you prepared are included in the PDF.

**Important:** If the notes on the AOS eServices website are missing, incorrect, or incomplete, then first confirm that you have the final version of the notes that you prepared on the UAN computer. Next, repeat any of the steps that may be necessary for ‘AFR - Notes & Documents’, starting on page 50. Then follow ‘Appendix 8: Recreate AFR – AOS Backup If Needed’ starting on page 121 to recreate and resubmit the AFR - AOS Backup within the AOS deadline, as listed on page 35.

**PUBLICATION REQUIREMENTS**

Each local government is required to publish a notice in the local newspaper that the Annual Financial Report is complete and that the report is available at the office of the fiscal officer. The notice needs to be published at the time the UAN member files their Annual Financial Report with the Auditor of State, which is accomplished by submitting the 2021 AFR – AOS backup by internet (or disc) submission to the Auditor of State.
Through a partnership between the Ohio Treasurer and the Auditor of State, local governments using UAN can choose to have UAN transmit their checkbook-level transactions to OhioCheckbook.gov in a quick, easy, and convenient process. When authorized by the fiscal officer, UAN will use the 2021 Annual Financial Report (AFR) data submitted to the Auditor of State (through UAN online or by disc) to submit the data to the Ohio Checkbook on your behalf.

UAN will not submit any data to Ohio Checkbook without your specific authorization for each fiscal year (previous fiscal years may also be authorized). You can authorize fiscal year 2021 through UAN only after closing the fiscal year, submitting the AFR data to UAN, and confirming the submission is successful by reviewing the filing status on the Auditor of State's Customer eServices website.

This is not a UAN requirement; those entities that choose to submit financial information to the Ohio Treasurer can take advantage of this convenient option. For more information, click or type in the UAN website home page into your internet browser:

https://uanlink.ohioauditor.gov/

Then select the Resources menu and then Ohio Checkbook to view instructions.

If, before closing, you did not print the year-end reports and applicable tax forms (W-2s, etc.). Instructions start on page 43, Appendix 2: Year End Reports.

For suggestions on beginning the year, see Appendix 4: New Year Accounting Procedures and Appendix 5: New Year Payroll Procedures starting on page 91. Reminder: Revenue and appropriation budgets are set to zero when the year is closed. However, if you logged into the work year 2022 during Temporary Mode and entered your 2022 Revenue Budgets and/or Temporary appropriations, those will remain in place after you close 2021.
APPENDIX 1: TEMPORARY MODE

UAN version 2022.1 *(the year end update)* includes Temporary Mode. In order to prepare for the use of this feature, please carefully review all of the important information provided in this appendix.

Temporary Mode allows you to work in both fiscal years 2021 and 2022 *before* closing fiscal year 2021, which provides many potential advantages. Opening Temporary Mode is a *required* step in the year end process, but working in 2022 before closing 2021 is *completely optional*. During Temporary Mode, you may select the work year upon login. See below:

This appendix is organized into four parts:
- **Part A** - Advantages of Temporary Mode
- **Part B** - Dating Rules in Temporary Mode
- **Part C** - Accounting in Temporary Mode
- **Part D** - Payroll in Temporary Mode

Important definitions:
- **Fiscal year** - The fund accounting budgetary year
- **Calendar year** - The year of the actual live date/computer date
- **Work year** - The fiscal year you have selected to work in (see picture above)

Please install 2022.1 as soon as you receive it. Note that installing it does not *automatically* open Temporary Mode or advance the application to 2022.

**PART A - ADVANTAGES OF TEMPORARY MODE**

Temporary Mode is available for sixty days after December 31, 2021 and includes both the accounting and payroll modules. You must manually initiate the opening of Temporary Mode, but it will close automatically when you close 2021.

While the calendar year is still 2021, not only can you continue with your typical day-to-day work for December 2021, you may also log into work year 2022 where you can enter:
- Revenue budgets for fiscal year 2022
- Temporary appropriations for fiscal year 2022
• Purchase Orders that apply to the fiscal year 2022 appropriations
• Payroll maintenance changes (employee setup or withholding rates) that will apply to the first wages posted in January 2022

While the calendar year is 2022, you will be able to perform your typical day-to-day work for 2022, and also log into work year 2021 where you can enter:
• Final 2021 interest receipts from checking accounts or investments
• Any electronic payments made before the end of the calendar year 2021
• *Most utility adjustments or other corrections that should apply to the fiscal year 2021*
• The December 31st bank reconciliation (after receiving your final bank statement)

PART B – DATING RULES IN TEMPORARY MODE

The rules that have governed post dates throughout 2021 still apply during Temporary Mode:
• Just as before, you can never backdate printed warrants in UAN; therefore, you cannot print warrants with a 2021 post date after the calendar date has passed December 31, 2021. However, remember that receipts and electronic payments may be backdated to reflect the actual calendar date that online (or phone) transactions were made, in order to be cleared on the correct bank reconciliation.
• Also just as before, you can forward date any payments up to thirty days beyond the calendar date within the work year. Consequently, in order to post transactions in the fiscal year 2022, you must be logged in to the work year 2022.

The only dating restriction specific to Temporary Mode is that 2022 transactions cannot be dated beyond the Temporary Mode period (i.e. sixty days after December 31, 2021). In other words, in order to post transactions dated March 1, 2022 or later, you must first close the fiscal year 2021.

Warning! All online or phone payments that you make in the calendar year 2022 must be posted in the work year 2022; do not improperly backdate such 2022 payments into the fiscal year 2021.

PART C - ACCOUNTING IN TEMPORARY MODE

1. Temporary Appropriations
   Be prepared! Your governing board should adopt 2022 temporary appropriations by December 31, 2021 in order to authorize encumbrances and expenditures on and after January 1, 2022. Temporary appropriations should include all expenses you may incur throughout the first quarter of the year. In Temporary Mode, you may enter temporary appropriations for the fiscal year 2022 prior to the closing of fiscal year 2021.

2. Permanent Appropriations
   UAN Temporary Mode does not change the proper legal procedures for adopting permanent appropriations. This means that your governing board should adopt permanent appropriations only after:
A. Fiscal year 2021 has been reconciled and closed
B. Fund balances and carryover encumbrances have been certified to the county auditor
C. The Amended Official Certificate of Estimated Resources has been received

After you add your revenue budgets into UAN (verifying that they balance, by fund, with the sum of the Taxes and Other Sources columns on your Amended Certificate), then you can add your permanent appropriations into the software. You must enter revenue budgets before entering the permanent appropriations - otherwise, your appropriations will be limited to your unencumbered January 1, 2022 fund balances.

**Warning!** Do NOT enter permanent appropriations for the fiscal year 2022 prematurely, i.e. prior to reconciling and closing the fiscal year 2021 (since you would not yet be able to accurately certify your fund balances and carryover encumbrances). If you do enter appropriations prematurely, and subsequently post new payments in the fiscal year 2021, you could potentially reduce the resources available for the fiscal year 2022 below what you had appropriated. This is a violation of the Ohio Revised Code.

**PART D - PAYROLL IN TEMPORARY MODE**

1. **2022 Wage Appropriations**
   As mentioned previously, you **MUST** enter 2022 appropriations before you will be able to post any 2022 payments (wages, withholding, or accounting payments). Therefore, your governing board must adopt temporary appropriations if you will need to post a 2022 payroll prior to the adoption of permanent appropriations.

2. **Payroll Maintenance**
   Payroll setup changes that are entered while logged into the work year 2021 **WILL ALSO** update the 2022 setup. For example, if you add a new school tax while logged into the work year 2021, that withholding will also be available when you log into the work year 2022. However, an important distinction is that maintenance changes entered while logged into the work year 2022 **WILL NOT** apply backward to 2021. **Warning!** As always, when updating any employee, be mindful of the effective date of the change; i.e. do not prematurely edit your employee setup. Also, be mindful of any changes in tax rates that will apply to the first wages posted in the fiscal year 2022 (regardless of the pay period).

3. **Calendar Year 2021**
   If you open Temporary Mode while the calendar date is still in 2021, you can continue to work in the fiscal year 2021 to post wages and withholding payments due to be paid that year. You may also log into the work year 2022 to make any necessary changes to employee earnings or withholdings applicable to the first payments to be posted in the fiscal year 2022 (and, if required for your payroll schedule, begin posting the first 2022 payments).

4. **Calendar Year 2022**
   After the calendar date is January 1, 2022 or later, any remaining unpaid 2021 withholdings will carry over for payment in the fiscal year 2022. However, you will still be able to log into the work year 2021 to post any electronic payments that you paid during the calendar year.
2021 but neglected to post in UAN at that time. Such items must be posted in the work year 2021 in order to be cleared on your December 31 bank reconciliation. **Warning!** All online or phone payments that you make in the calendar year 2022 must be posted in the work year 2022; do not improperly backdate such 2022 payments into the fiscal year 2021.

5. **Withholding Liabilities and Reporting** *(Reminder)*
   OPERS and OP&FPF reporting and remittance months for wages are determined by **pay period end dates**, while Federal, State, School, and Local tax liabilities are instead determined by **paycheck post dates**. Example: Wages with December 2021 pay period end dates posted in January 2022 will be included on the OPERS and/or OP&FPF reports for December 2021, but also correctly recognized as 1st quarter 2022 Federal, State, School & Local tax liabilities.

6. **You cannot do the following in Temporary Mode in Payroll:**
   a. Remove or Delete any payroll items in either work year.
   b. Post Wage Reallocations or Wage Adjustments in the work year 2022.
   c. Clear Unpaid Withholdings in the work year 2022.
   d. Use the Withholding Overpayment utility in the work year 2022.

   After the fiscal year 2021 is closed, these actions will be available again for the fiscal year 2022.
OVERVIEW

You may print year-end reports before or after closing the year. If you choose to print them before closing the year, make sure you have completed all transactions, utility adjustments, and post your final December 31 bank reconciliation. Otherwise – if you complete any of those activities after printing the year-end reports, many of those reports will need to be re-printed.

**Important Note:** Some year-end reporting requires manual input into UAN or external add-in documents. You cannot submit separate document files. You must complete the manual input and add-in steps that apply to your entity, for UAN to compress it into the AFR-AOS Backup. You are required to complete all steps prior to the final year-end audit submission (AFR-AOS Backup) and UAN must receive it before the deadline set by the Auditor of State - financial penalties may be assessed for late filings. These include the two items with asterisks “*” below and 4B - AFR Demographics & Debt (page 9).

**Summary of year end reports:**
This list includes all possible year end report requirements
1. *AFR Requiring Manual Input* (Schedule of Debt Service,…etc.) pg. 45
2. *AFR - Notes & Documents* (Notes, MD&A) pg. 50
3. **AFR - OCBOA Statements** (Net Position, Activities,…etc.) pg. 55
4. **AFR - Regulatory Statements** (Combined & Combining,…etc.) pg. 56
5. **December 31st Year-To-Date Reports** (ledgers, cash journal,…etc.) pg. 58
6. **Payroll Specific Year End Reports** pg. 59
7. **1099 Forms – Filing Overview & Important Notice** pg. 60
8. **1095 & 1094 Forms** pg. 68
9. **944 Federal Annual Tax Return** pg. 70
10. **Appendix 3: W-2 & W-3 Forms** pg. 71

Entities filing Regulatory annual financial reports can **skip** ‘AFR - OCBOA Statements.’ Entities filing OCBOA annual financial reports can **skip** ‘AFR - Regulatory Statements.’

**Printing 2021 reports after closing the year or while in Temporary Mode work year 2022**
You do not have to log into the work year 2021 to print 2021 reports. To print from a prior year, open the report area and click on the ‘Year’ menu in the upper left corner and select the fiscal year of the report you would like to print. As seen in the following example:
Saving reports in Adobe PDF file format

Year end reports (except for 1099/1096, W-2 and W-3 forms) can be saved as a file in Adobe PDF file format (PDF). To save a report as a PDF file, follow all of the normal steps to print except instead of clicking Print, click **Save PDF** located in the lower right corner of the report area. This will open a ‘Save As’ window, enabling you to save the file in any directory (i.e. folder). The default directory is C:\_UAN_Efiles.

Other ‘Save As’ Window Options

To save the file to a different folder, click the shortcuts listed in the left pane of the window. Based on your selection on the left, sub-folders will display in the right pane of the window. If needed, continue to open the folders on the right (double-clicking) until you have navigated to the folder of your choice. Another option is to click the arrow to the right of the folder path located at the top of the ‘Save As’ window to open a menu where you can browse to recently used folders. To change the file name, type it in the ‘File name’ field:
Some annual reports require financial data that you would not input in the normal course of the year, but you should input annually. These may include:

- Cash/Other Assets Not Recorded
- Cash Reconciliation
- Schedule of Debt Service
- Schedule of Outstanding Debt

It is possible that none of these reports may apply to your entity. *Skip those that do not apply.* However, *all applicable reports* are required to be included in your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings.

**Recommendation:** By using Temporary Mode, you might gain some extra time to complete these items before closing the fiscal year.

*UAN Menu:* General → Reports & Statements → Year End → **All four reports** list in the menu and each will have options to Print, Display, or Save PDF once you input data.

### CASH/OTHER ASSETS NOT RECORDED

Does the entity have any cash or other assets that belong to the entity that is not on its books? Some examples of cash not recorded that you might enter on this report:

- Money with a financial institution for servicing debt
- Money held in escrow for construction
- Money held by a third party administrator servicing claims for a self-insurance program
- Money held in a deferred compensation program under – 26 USC § 457
- Money held in segregated accounts by other government officials
- Money held by a trustee to satisfy the covenants of a bond indenture
- Money in a payroll clearing account

If necessary, click Add to open the form. Enter the account number, institution name, description, and asset amount. Click Save and repeat these steps for all accounts.
CASH RECONCILIATION

This statement compiles information regarding depository balances (checking accounts) and investment information (treasury bonds, certificates of deposit, other investments).

You are only required to enter data for this statement if your entity has one or more of the following segregated accounts i.e. accounts not included on the books or financial statements of your government. Possible segregated account types for input:

- Bond and Coupon Clearance Account (Not held in Pool)
- Payroll Clearing Account (Not held in Pool)
- Retainage Accounts (Not held in Pool)
- Debt Accounts (Related to Bond Indenture and Not held in Pool)
- Other Outside Accounts (Not held in Pool)

The balances entered should be after considering all reconciling items including outstanding checks. After you print this report, compare the Cash Reconciliation statement to the Fund Status report. If there are any differences, contact UAN for assistance in locating the discrepancy.

You can export the Cash Reconciliation to an Excel spreadsheet. Complete the form and click Export and a file will save to C:\_UAN_Efiles. Use Windows File Explorer to browse and open the spreadsheet. It is designed to make it easier to incorporate information from this report into the Notes the Annual Financial Statements.

SCHEDULE OF DEBT SERVICE

This schedule shows the combined outstanding principal and interest of all debt for the years following December 31, 2021. Each year that you enter should show the combined principal and combined interest for all scheduled debt payments in that year. However, you must retain the detailed information with your records for all debt service to maturity, since this information is subject to review during your audit. You should be able to obtain the information required for this debt schedule from your files or the lender.

Click Add and starting with 2022, enter the combined principal and combined interest for all outstanding notes and bonds for that year. Click Save, enter 2023, and then enter the combined principal and combined interest for all outstanding notes and bonds for that year. Continue this format for the first five years. After the first five years, group the remaining years in five-year sets of principal and interest. Repeat this process for all five-year sets until all debt maturity is reached. Make note that this is also the same format used in the Notes to the Annual Financial Statements. Please review the example that follows:
### SCHEDULE OF DEBT SERVICE – CALCULATION EXAMPLE

Debt outstanding as of December 31, 2021:

<table>
<thead>
<tr>
<th>Outstanding Principal</th>
<th>Principal Payment* Per Year</th>
<th>Interest Payment* Per Year</th>
<th>Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPWC Loan #1</td>
<td>$150,000.00</td>
<td>$10,000.00</td>
<td>$2,000.00</td>
</tr>
<tr>
<td>Truck Loan #2</td>
<td>20,000.00</td>
<td>5,000.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

* Note: the principal and interest payments are stated as non-fluctuating amounts in this example to make it simple to understand.

The example’s calculated total debt schedule entries by year, as of December 31, 2021:

<table>
<thead>
<tr>
<th>Year</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Principal</td>
<td>OPWC Loan 1 + Truck Loan 2</td>
<td>Loan interest 1 + 2</td>
<td></td>
</tr>
<tr>
<td>2022</td>
<td>$15,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest</td>
<td>2,100.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2023</td>
<td>$15,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest</td>
<td>2,100.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2024</td>
<td>$15,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest</td>
<td>2,100.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2025</td>
<td>$15,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest</td>
<td>2,100.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2026</td>
<td>$10,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest</td>
<td>2,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2031</td>
<td>Combine 2027 through 2031</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Principal</td>
<td>$50,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest</td>
<td>10,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2036</td>
<td>Combine 2032 through 2036</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Principal</td>
<td>$50,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest</td>
<td>10,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**FAQ:** Can I enter the same data from the 2020 Schedule of Debt Service’s year end reports?

No, you cannot because the first year on the 2020 Schedule of Debt Service is not reported on the 2021 Schedule of Debt Service. Each year you must report the remaining debt payments until
maturity starting with the next fiscal year. If you have more than five years until all debt is paid the five-year sets from last year are not the same; every year, the grouped years are different. In addition, you may have issued more debt that must be added to the compiled information.

**SCHEDULE OF OUTSTANDING DEBT**

You must describe all debt activity for 2021 on this schedule with each note or bond described as a separate item. You must retain detailed information in your records for each outstanding debt pertaining to 2021, as this information is subject to review during your audit. If necessary, you should be able to obtain the information required for this schedule from your files or the lender. Click ‘Add’ to start with the first note or bond to enter.

**Continue to the next page to view two examples **
SCHEDULE OF OUTSTANDING DEBT – EXAMPLES:

**Example A:** In 2020 the government had a $25,000 note issued for a truck. In 2021, the government paid $5,000.00 of principal on this note. Enter the data like this:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Entered:</th>
<th>Explanation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year Issued:</td>
<td>2020</td>
<td></td>
</tr>
<tr>
<td>Description:</td>
<td>Purchase of truck (Zoning)</td>
<td></td>
</tr>
<tr>
<td>Interest Rate:</td>
<td>1.9%</td>
<td></td>
</tr>
<tr>
<td>Balance Jan 1:</td>
<td>$25,000.00</td>
<td>Balance of the note as of 1/1/2021</td>
</tr>
<tr>
<td>Issued:</td>
<td>$ 0.00</td>
<td>No additional amount was issued in 2021, so it is zero.</td>
</tr>
<tr>
<td>Retired</td>
<td>$5,000.00</td>
<td>Principal paid on a note in 2021</td>
</tr>
<tr>
<td>Balance Dec 31:</td>
<td>$20,000.00 (Calculated field)</td>
<td>Note balance as of 12/31/2021</td>
</tr>
</tbody>
</table>

**Example B:** In 2021, the same government accepted an OPWC loan of $150,000.00 for a stormwater improvement project. Enter the data like this:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Entered:</th>
<th>Explanation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year Issued:</td>
<td>2021</td>
<td></td>
</tr>
<tr>
<td>Description:</td>
<td>Stormwater improvements</td>
<td></td>
</tr>
<tr>
<td>Interest Rate:</td>
<td>3.9%</td>
<td></td>
</tr>
<tr>
<td>Balance Jan 1:</td>
<td>$ 0.00</td>
<td>The note was issued in 2021, so the 1/1/2021 balance was zero.</td>
</tr>
<tr>
<td>Issued:</td>
<td>$150,000.00</td>
<td>Amount issued in 2021</td>
</tr>
<tr>
<td>Retired</td>
<td>$0.00</td>
<td>Amount paid on the note in 2021</td>
</tr>
<tr>
<td>Balance Dec 31:</td>
<td>$150,000.00 (Calculated field)</td>
<td>Note balance as of 12/31/2021</td>
</tr>
</tbody>
</table>

_Program output_
UAN does not generate certain AFR documents (whether required or optional) when there is nothing in the day-to-day software activities that would produce them. Instead, you can prepare these documents outside of UAN and then add them into the application.

You **cannot** submit separate files. You are required to add all external documents applicable to the entity into UAN in order for UAN to compress* them into the AFR-AOS Backup – which is a single file created during the year end closing that you choose to either submit automatically by internet or to a disc for mailing. You are required to complete all steps prior to the final year-end audit submission (AFR-AOS Backup) and UAN must receive it **before the deadline** set by the Auditor of State - financial penalties may be assessed for late filings.

*File Compression is a technology that enables you to submit just one file (the AFR-AOS Backup) that will contain all your annual financial statements – including all add-in documents. A compressed file contains one or more files that are smaller than their original file sizes. This makes internet uploading faster and easier, and when applicable, it allows more data to be stored on a disc. So, as long as you follow the steps to add the files into UAN **before** closing the fiscal year, the files will compress into the AFR-AOS Backup.

**Recommendation:** By using Temporary Mode, you might gain some extra time to complete these items before closing the fiscal year.

**Regulatory – Required and Optional add-in documents:**
- **Required:** Notes to the Annual Financial Statements
- Supporting documents that you choose to submit or that audit requests (when applicable).

**OCBOA – Required and Optional add-in documents:**
- **Required:** Notes to the Annual Financial Statements
- **Optional:** Management’s Discussion and Analysis
- Rarely required: Required Supplementary Information – it has been very uncommon for UAN clients to be required to submit RSI documents. Use for those rare instances or for entities that simply choose to file RSI.
- Supporting documents that you choose to submit or that audit requests (when applicable).

**Additional Resources:**
- Please refer to AOS Bulletin 2015-007 for more information on the submission of Notes. To view the bulletin, type the following address into your web browser:
- Then scroll to the bulletin number at the bottom of the web page and click the link to open it.
Local Government Services provides a ‘shell’ (i.e. guide/sample) of each type of MD&A and Notes on the AOS website. To access, type the address that follows into your web browser:

For OCBOA shells:
https://ohioauditor.gov/references/shells/gasb34ocboa.html

For Regulatory shells:
https://ohioauditor.gov/references/shells/regulatory.html

Instructions for saving and opening the AOS shells:
After opening the applicable web page, scroll to the line listing your entity type and click ‘Notes’. Different computer browsers may display a notification about the file download in different ways. Some will display a separate window with the file options: ‘Open, Save, or Save As’. Others will display a message at the bottom of the web page similar to these:

OR

As seen in the image that follows, click the (1) ellipse (or an upward arrow) next to the message and then from the menu select (2) Open

Upon opening it, sometimes the browser will display a message at the top or bottom of the screen similar to the one below:
Click the ‘Enable Editing’ button and then click the File menu. Click ‘Save As’ and browse to a file folder of your choice, such as the ‘Documents’ folder. As of the print date of the year end procedures, the file name for the township regulatory notes shell is:

‘AOS_Regulatory_Basis_Township_Footnote_Shell_Dec2020.docx’

UAN recommends renaming the file name to something simple and unique to your entity, such as ‘2021 Example Township AFR Notes’.

If you are unsure of which notes to the annual financial statements are applicable for your entity type or have questions about the content of the note shells, please review all applicable information provided on the AOS website, and then if needed, contact Local Government Services at ContactLGS@ohioauditor.gov or 800-345-2519.

**EXPORT AN EXCEL FILE THAT WILL HELP WITH NOTES PREPARATION**

**UAN Menu**: General → Reports & Statements → Year End → AFR – Regulatory Statements, select ‘Budgetary Notes Information Export’ from the menu. Click Export and an Excel file will save to C:\_UAN_Efiles. Use Windows File Explorer to browse and open the spreadsheet to review. It is designed to make it easier to incorporate budgetary disclosures into the Notes to the Annual Financial Statements.

**STEPS TO SAVE MICROSOFT WORD FILES TO ADOBE PDF FORMAT:**

Add-in documents are restricted to files formatted in Adobe PDF. The Auditor of State’s Office requires this so that all add-in files will be a uniform file type. *Reminder: all 2021 add-in files will compress into one AOS submission file (the AFR-AOS Backup) when you close the fiscal year.*

The following steps explain how to save a Microsoft Word file to the Adobe PDF format:

Open the Word document. Click the ‘File’ menu and click ‘Save As’ and a ‘Save As’ window will open similar to the following example.
If needed, use the browsing pane on the left to navigate to a folder in which you would like to save the file (for example, Documents). Confirm or edit the ‘File name’ field. Click the ‘Save as type’ menu and select ‘PDF’. Then click ‘Save’ and a PDF file version of your Word document will be saved there. Depending on the computer’s Microsoft default options, it may or may not automatically open the PDF after processing. If not, press the Window’s key º and start typing ‘File Explorer’ and when it appears as a ‘Best Match’ list, click to open it. Browse to the location where you saved the file to view and confirm it saved correctly.

** Continue to the next page for instructions on using the AFR – Notes & Documents area**

USING THE AFR – NOTES & DOCUMENTS AREA

UAN Menu: General → Reports & Statements → Year End → AFR – Notes & Documents

Confirm the ‘Year’ menu is set to 2021 (located to the right of the Add button). If not, click to change it to 2021 before continuing.

Add
1. Click ‘Add’ to open the ‘Add AFR Document’ form.
2. Click ‘Browse’ to open a Window’s ‘Open’ form to pick the file.
   If necessary, use the shortcuts or Search option in the Window’s ‘Open’ file form to navigate to the computer directory to the file location.
3. Select the file, and then click ‘Open’ to return to the ‘Add AFR Document’ form.
4. Click ‘Save’ in the ‘Add AFR Document’ form to save the file to the ‘AFR – Notes & Documents’ list. UAN will include all files in the list when you process the next AOS submission by internet (or disc).

Delete
Use to delete documents added in error or that revised documents will replace.

Display
Display will open the selected PDF file.

IMPORTANT:
Make sure that you use the display button to verify that the correct information was added-in successfully to the AFR – Notes & Documents area.

- If you added the wrong file, then delete the file in the AFR – Notes & Documents area.
  Use Window’s File Explorer to identify the location of the correct PDF file. Return to the AFR – Notes & Documents area in UAN and repeat the ‘Add’ steps to add the correct file.

- If the file needs to be revised, then delete the file in the AFR – Notes & Documents area.
  Open the file in the application in which it was originally created (e.g. MS Word) and complete any necessary changes. Save the revised copy in the original application and then save it as a PDF file. Return to the AFR – Notes & Documents area in UAN and repeat the ‘Add’ steps to add the updated file.
AFR - OCBOA STATEMENTS

***Those filing the Regulatory annual financial report type should SKIP this section. It is not required for Regulatory filing ***

It is not necessary to send a paper copy of the AFR to the Auditor of State's Office. The entity’s annual financial report information will be submitted as part of the ‘AFR – AOS Backup’ internet (or disc) submission when you close the year. However, entities should maintain at least one printed copy of the annual financial reports for public record purposes. UAN also recommends that you save the reports as PDF files for future public records requests.

UAN Menu: General ➔ Reports & Statements ➔ Year End ➔ AFR – OCBOA Statements, select the year and then the statement name. By default, all amounts listed on AFR statements round to the nearest whole dollar as required by the Auditor of State’s Office. If you would like to print the statements for internal use with amounts rounded to the nearest penny for precise comparison with non-AFR reports, click the ‘Options’ tab and remove the checkmark ‘Round to whole dollars’.

Print the following OCBOA statements:

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Position</td>
<td>Statement of Net Position</td>
</tr>
<tr>
<td>Activities</td>
<td>Statement of Activities</td>
</tr>
<tr>
<td>Governmental – Fund Balances</td>
<td>Statement of Assets and Fund Balances – Governmental Funds</td>
</tr>
<tr>
<td>Governmental – Changes</td>
<td>Statement of Receipts, Disbursements and Changes in Fund Balances – Governmental Funds</td>
</tr>
<tr>
<td>Budgetary</td>
<td>Statement of Receipts, Disbursements and Changes in Fund Balance – Budget and Actual – Budget Basis</td>
</tr>
</tbody>
</table>

Additional OCBOA statements for entities with proprietary and/or fiduciary funds:

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proprietary – Net Position</td>
<td>Statement of Fund Net Position – Proprietary Funds</td>
</tr>
<tr>
<td>Proprietary – Changes</td>
<td>Statement of Receipts, Disbursements and Changes in Fund Net Position – Proprietary Funds</td>
</tr>
<tr>
<td>Proprietary – Cash Flow</td>
<td>Statement of Cash Flows – Proprietary Funds</td>
</tr>
<tr>
<td>Fiduciary – Net Position</td>
<td>Statement of Fiduciary Net Position – Fiduciary Funds</td>
</tr>
<tr>
<td>Fiduciary – Changes</td>
<td>Statement of Changes in Fiduciary Net Position – Fiduciary Funds</td>
</tr>
</tbody>
</table>
***Those filing the OCBOA annual financial reports should SKIP this section.
It is not required for OCBOA filing ***

It is not necessary to send a paper copy of the AFR to the Auditor of State's Office. The entity’s annual financial report information will be submitted as part of the ‘AFR – AOS Backup’ internet (or disc) submission when you close the year. However, entities should maintain one printed copy of the annual financial reports for public record purposes. UAN also recommends saving the reports as PDF files in case of public records requests.

**UAN Menu**: General → Reports & Statements → Year End → AFR – Regulatory Statements, select the year and then the statement name. By default, all amounts listed on AFR statements round to the nearest whole dollar as required by the Auditor of State’s Office. If you would like to print the statements for internal use with amounts rounded to the nearest penny for precise comparison with non-AFR reports, click the “Options” tab and remove the checkmark ‘☑ Round to whole dollars’.

Print the following Regulatory statements:

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combining Statement – Governmental</td>
<td>Combining Statement of Receipts, Disbursements and Changes in Fund Balances (Cash Basis)*</td>
</tr>
<tr>
<td>Combined Statement – Governmental</td>
<td>Combined Statement of Receipts, Disbursements and Changes in Fund Balances (Cash Basis)*</td>
</tr>
<tr>
<td>Comparison of Budgeted and Actual Receipts</td>
<td>Comparison of Budgeted and Actual Receipts</td>
</tr>
<tr>
<td>Comparison of Disbursements and Encumbrances</td>
<td>Comparison of Disbursements and Encumbrances with Expenditure Authority</td>
</tr>
<tr>
<td>Reconciliation of Interfund Transactions</td>
<td>Reconciliation of Interfund Transactions</td>
</tr>
</tbody>
</table>

*Page subtitles will vary depending on the type of funds.

**Recommendation**: Select ‘Budgetary Notes Information Export’ from the menu. Click Export and an Excel file will save to C:\_UAN_Efiles. Use Windows File Explorer to browse and open the spreadsheet to review. It is designed to make it easier to incorporate budgetary disclosures into the Notes the Annual Financial Statements.

*Continue to the next page for Regulatory statements for proprietary and/or fiduciary funds*
Additional Regulatory statements for entities with proprietary and/or fiduciary funds:

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combining Statement – Proprietary and Fiduciary</td>
<td>Combining Statement of Receipts, Disbursements and Changes in Fund Balances (Cash Basis)*</td>
</tr>
<tr>
<td>Combined Statement – Proprietary and Fiduciary</td>
<td>Combining Statement of Receipts, Disbursements and Changes in Fund Balances (Cash Basis)*</td>
</tr>
</tbody>
</table>

*Page subtitles will vary depending on the type of funds.*
Print reports that include a record of all entity activity from January 1 to December 31, 2021. Optionally, save each report as a PDF file. The AOS audit division recommends that entities retain year-to-date reports. Monthly reports are acceptable only if you have printed a final monthly report each (and every) month. Suggested reports are in the list below. Select the report from the drop-down menu and then 2021. Depending on the report, the date range must be set to either ‘Year’ or ‘As of’ 12/31/2021.

<table>
<thead>
<tr>
<th>UAN MENU: Accounting → Reports &amp; Statements</th>
<th>REPORT</th>
</tr>
</thead>
<tbody>
<tr>
<td>→ Appropriation Reports</td>
<td>Appropriation Ledger</td>
</tr>
<tr>
<td></td>
<td>Appropriation Status</td>
</tr>
<tr>
<td>→ Bank Reconciliation Reports</td>
<td>Bank Reconciliation Report</td>
</tr>
<tr>
<td>→ Cash Reports</td>
<td>Cash Journal</td>
</tr>
<tr>
<td>→ Fund Balance Adjustment Reports</td>
<td>Fund Balance Adjustment Listing</td>
</tr>
<tr>
<td>→ Fund Reports</td>
<td>Cash Summary by Fund</td>
</tr>
<tr>
<td></td>
<td>Fund Status</td>
</tr>
<tr>
<td>→ Interfund Advance Reports</td>
<td>Interfund Advance Listing</td>
</tr>
<tr>
<td>→ Interfund Transfer Reports</td>
<td>Interfund Transfer Listing</td>
</tr>
<tr>
<td>→ Investment Reports</td>
<td>Investment Journal</td>
</tr>
<tr>
<td>→ Purchase Order Reports</td>
<td>Purchase Order Status</td>
</tr>
<tr>
<td></td>
<td>Select the report and click the Filters tab to select the Status ‘All’ to print open &amp; closed purchase orders (the default only lists Open POs)</td>
</tr>
<tr>
<td>→ Receipt Reports</td>
<td>Receipt Listing</td>
</tr>
<tr>
<td></td>
<td>Select and click the Sorting tab, and select ‘Deposit Ticket then Receipt Number’. Most useful if you entered deposit ticket numbers in receipts.</td>
</tr>
<tr>
<td></td>
<td>Receipt Detail</td>
</tr>
<tr>
<td>→ Revenue Reports</td>
<td>Revenue Ledger</td>
</tr>
<tr>
<td></td>
<td>Revenue Status</td>
</tr>
<tr>
<td>→ Payment Reports</td>
<td>Payment Listing</td>
</tr>
<tr>
<td></td>
<td>Payment Register Detail</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GENERAL → Reports &amp; Statements</th>
<th>REPORT</th>
</tr>
</thead>
<tbody>
<tr>
<td>→ Vendor / Payee Reports</td>
<td>Vendor / Payee Receipt Register</td>
</tr>
<tr>
<td></td>
<td>Vendor / Payee Payment Register</td>
</tr>
</tbody>
</table>
PAYROLL SPECIFIC YEAR END REPORTS

UAN does not provide a list of payroll reports to print at year end, although you may want to select some reports to Print or PDF for the year. The payroll reports you will have to present at your next audit include the forms W-2 and W-3, all monthly and/or quarterly tax and retirement reports you have filed, and the payments corresponding to these reports. You should have physical copies of these reports for your next audit. If you did not keep physical copies of reports filed, gather that information now. Note that UAN will generate reports that indicate what you *should* have reported, but it may not reflect what you *actually* filed.

Often the December and/or 4th Quarter reports are forgotten in the busy rush of closing the year. Remember that you must file the December OPERS/OP&FPF Retirement reports after you have posted the final wages for pay periods ending in December. You must also file Federal, State, and Local tax reports for the month and/or quarter, and the 4th quarter ODJFS (Ohio Department of Job & Family Services) Wage Detail after you have posted all wages with December post dates. You must print the W-2 and W-3 forms, and submit them per IRS instructions to the employees and the Social Security Administration.

State, School, and Local taxes many times require you to file an annual report that compiles all wages and withholdings for the year to submit with or in addition to the forms W-2. It is your responsibility to contact these agencies to determine the forms you need and the deadlines to file. Reports you may want to print to complete these reports:

**UAN Menu**: Payroll → Reports & Statements → Tax Reports – Other (select Ohio Tax Report, School Tax Report, and/or Local Tax Report). Mark “Year”, select all items, and Print.

1099 REQUIRED – FLAG VENDORS AHEAD OF TIME

You can flag the vendors in UAN to make it easier to select all vendors that the IRS requires you to send a 1099 form when the time comes each year. To put a vendor on the ‘1099 required’ list, go to General → Maintenance → Vendors/Payees, checkmark the vendor and click Edit. In the Edit Vendor/Payee form mark as ‘☑ 1099 Required’ in the Vendor/Payee form. To save the form you must include the vendor’s Tax ID or Social Security Number from the IRS Form W-9. If you still need this from the vendor, mark ‘☑ W-9 Needed’ as a reminder to contact the vendor for this information.

Many of the reports under General → Reports & Statements → Vendors/Payees, such as the Vendor/Payee Listing, will include this information so that you can review it throughout the year to be sure vendors are up-to-date.
Form 1099-NEC and Form 1099-MISC

- The IRS has not authorized using UAN for printing these forms on plain paper.
- The IRS provides an option to file these forms electronically.
- Most likely very few UAN clients will need to process Form 1099-Misc, although each fiscal officer should closely review the IRS requirements to make a determination.

IMPORTANT

The Vendor / Payee ‘Address Line 2’ will no longer print on 1099-NEC Forms due to recent IRS changes (it will continue to print 1099-Misc Forms).

In the 4th quarter of 2021, the IRS announced a 1099-NEC formatting change from 2-part to 3-part forms beginning with the 2021 reporting year (the 1099-Misc Forms will continue to be 2-part forms). To accommodate the IRS change, UAN developers had to stop the vendor’s location address ‘Line 2’ from copying into the 1099-NEC forms. Line 2 is not widely used by UAN clients so most will be unaffected. You must confirm whether your entity has any vendors with essential 1099-NEC address information in Line 2 and then edit to include that information on Line 1.

REVIEW VENDORS REQUIRING A 1099-NEC FORM

Find out if any of your vendors requiring a 1099-NEC are affected. An easy way to do this is to export a spreadsheet version of the Vendor / Payee report called ‘Export Vendor / Payee’

- General → Reports & Statements → Vendor / Payee Reports. Select ‘Export Vendor / Payee’ from the menu and select 2021.
- Select the ‘Filters’ tab and change the ‘1099 Required’ menu from ‘All’ to ‘Yes’ to exclude all vendors that are not marked as ‘1099 Required’ in their vendor settings.
- Select all vendors and click Export to create an Excel file. A Window’s ‘Save As’ screen will open listing the file name ‘Export Vendor Payee …’ and the file location it will be saved (the default will be C:\_UAN_Efiles). Click Save.
- Use Windows File Explorer to open the ‘Export Vendor Payee …’ Excel file. Find the ‘Address Line 2’ column and scroll the list to identify vendors with essential information (if any) for the 1099-NEC. Make a list of those you will need to edit.

Are any of the vendors affected? If yes, UAN recommends editing the vendor’s address in General → Maintenance → Vendors / Payees before you add the 2021 1099-NEC forms so that the change will affect all future forms and reports. Follow the steps on the next page.
Steps to edit a Vendor/Payee Location:

1. General → Maintenance → Vendors / Payees.
2. Checkmark a vendor and click Edit.
3. Checkmark a Location and click Edit.
4. Complete the address edits and then click Save and Close.
   (Repeat steps 3-4 if there are multiple Locations affected).
5. Click Close to return to the list of vendors.
   (Repeat steps 2-5 for all vendors affected.)

*Tip:* If you are comfortable using the navigation arrows at the bottom of each form (for example, the arrows), you can enter changes more efficiently than one vendor or location at a time by clicking the arrows to move to the next item selected.

*Important:* if you wait to enter the changes until after closing the fiscal year 2021, editing the vendor will not update the 2021 1099-NEC form even if you delete and add a new 1099-NEC form. In that case, you will need to edit the 2021’s 1099-NEC form directly, as well as edit the vendor (steps above) for future reports and forms.
1099-NEC & 1096 FORMS

UAN Menu: General → Reports & Statements → Year End → 1099-NEC & 1096 Forms. Upon opening, confirm or change the Year to 2021.

Add  Click to add vendors to the list of those for whom you will print forms 1099-NEC. Read the message and click OK to open the Add form. If needed, filter the vendors by Vendor Type or Payment Total (see below). Then mark the checkboxes next to the vendors to include. Click Save to add them to the 1099-NEC & 1096 Forms list. **Note:** You may add only one 1099-NEC form per vendor, per selected year. Existing forms are available to edit or delete.

**Vendor Type section**
- 1099 Required. This narrows down the vendor list on the Add form to include only vendors previously marked as ‘1099 Required’ in General → Maintenance → Vendors/Payees.
- All Vendors: Select this option to list ALL vendors, regardless of whether they are marked ‘1099 Required’ on the Vendor/Payee form.

**Payment Total section**
- At Least: You can narrow down the list to show only vendors that have payments totaling at least $[fill in an amount] that year.
- Any Amount: regardless of the payment amount, selecting this will display all vendors based only on your selection of 1099 Required or All Vendors.

Click ‘Update Grid’ to apply any changes to the Vendor list.

**Edit**  Use to override any default vendor information relevant to the 1099-NEC form. Select the vendors and click Edit to view and override data when necessary.

**Note:** direct edits to the 1099-NEC form will not permanently update the vendor information in UAN. When you still have access to the older fiscal year, it is better to first delete the 1099-NEC, correct the source of the problem in UAN, then add the 1099-NEC form so it will include the new information. For example, if the address is incorrect, you would edit the Vendor/Payee form in General → Maintenance → Vendor/Payees. Another correction might involve posting an electronic payment that is missing in UAN. However, if you discover an error after closing of the fiscal year, the correction in other areas of UAN will not update by adding a new 1099-NEC form. In that case, you will need to edit the 1099-NEC form as well as correct the problem elsewhere.
Edit 1099-NEC form sections:

Vendor
Location menu: you can change the address that will print on the 1099 form by selecting an alternate if previously set up in General → Maintenance → Vendor / Payees.

☐ Print Name & Address: Saved. This setting brings data into the form from General → Maintenance → Vendor / Payees.
☐ Print Name & Address: Override. Use this when you need to revise the 1099 form. This will not change the Vendor / Payee information in UAN.

ID & Account #
☐ Print ID & Account #: Saved. This setting brings data into the form from General → Maintenance → Vendor / Payees.
☐ Print ID & Account #: Override. Use this when you need to revise the 1099 form. This will not change the Vendor / Payee information in UAN.

Other
☐ Mark as Corrected. Marking will fill in the corresponding box on the 1099-NEC and open fields to enter the corrected name and Original ID / Name.
☐ Mark as 2nd TIN not. Marking will fill in the corresponding box on the 1099-NEC.

Amounts
☐ Print Amounts: Calculated. Box 1 will include the total year’s payments posted to the vendor in UAN. All other boxes are blank by default.
☐ Print Amounts: Override - use this when it is necessary to override any calculated amount.

UAN cannot provide tax advice on whether you should override any of Box calculations/defaults. Please review IRS instructions for this form at https://www.irs.gov/pub/irs-pdf/i1099mec.pdf and if necessary, contact the IRS or a tax advisor.

Other buttons below the 1099-NEC & 1096 Forms area:
Delete Click to remove any vendor on the list in error or if you are replacing it with a new form.
Print 1099 Click to print the marked vendors. Make sure to load blank 1099-NEC forms.
Print 1096 Click to print the marked vendors. Make sure to load a blank 1096 form.
File Create a file for upload. Instructions follow on the next page.
CREATE A 1099-NEC FILE FOR UPLOADING

The IRS includes an option for filing 1099-NEC forms electronically. Review the IRS webpage ‘Filing Information Returns Electronically (FIRE)’

https://www.irs.gov/FIRE

This webpage is current as of the Year End Procedures print date.

Create the file with UAN:

- Available beginning with the filing year 2020 and following years only.

- After you finish adding and editing vendor 1099-NEC forms in UAN, select all vendors that you will be submitting the IRS information.

- Click File and read the message carefully. Click OK to continue and a form will open:

  - A Transmitter Control Code (TCC) is required to transmit the returns. Review the IRS FIRE System webpage about this requirement.

  - Confirm or fill in all required fields and click Save. Note the file name and location:

  - Review the IRS FIRE System webpage for steps to upload the file.
**1099-MISC & 1096 FORMS**

**Note:** most likely very few UAN clients will need to process Form 1099-Misc, although each fiscal officer should closely review the IRS requirements before making a determination.

**UAN Menu:** General → Reports & Statements → Year End → 1099-Misc & 1096 Forms. Upon opening, confirm or change the Year to 2021.

**Add** Click to add vendors to the list of those for whom you will print forms 1099-Misc. Read the message and click OK to open the Add form. If needed, filter the vendors by Vendor Type or Payment Total (see below). Then mark the checkboxes next to the vendors to include. Click Save to add them to the 1099-Misc & 1096 Forms list. **Note:** You may add only one 1099-Misc form per vendor, per selected year. Existing forms are available to edit or delete.

**Vendor Type section**
- **1099 Required.** This narrows down the vendor list on the Add form to include only vendors previously marked as ‘1099 Required’ in General → Maintenance → Vendors/Payees.
- **All Vendors:** Select this option to list ALL vendors, regardless of whether they are marked ‘1099 Required’ on the Vendor/Payee form.

**Payment Total section**
- **At Least:** You can narrow down the list to show only vendors that have payments totaling at least $[fill in an amount] that year.
- **Any Amount:** regardless of the payment amount, selecting this will display all vendors based only on your selection of 1099 Required or All Vendors.
Click ‘Update Grid’ to apply any changes to the Vendor list.

**Edit** Use to override any default vendor information relevant to the 1099-Misc form. Select the vendors and click Edit to view and override data when necessary.

**Note:** direct edits to the 1099-Misc form will not permanently update the vendor information in UAN. When you still have access to the older fiscal year, it is better to first delete the 1099-Misc, correct the source of the problem in UAN, then add the 1099-Misc form so it will include the new information. For example, if the address is incorrect, you would edit the Vendor/Payee form in General → Maintenance → Vendor/Payees. However, if you discover an error after closing of the fiscal year, the correction in other areas of UAN will not update by adding a new 1099-Misc form. In that case, you will need to edit the 1099-Misc form as well as correct the problem elsewhere.
Edit 1099-Misc form sections:

**Vendor**
Location menu: you can change the address that will print on the 1099 form by selecting an alternate if previously set up in General → Maintenance → Vendor / Payees.

- Print Name & Address: Saved. This setting brings data into the form from General → Maintenance → Vendor / Payees.
- Print Name & Address: Override. Use this when you need to revise the 1099 form. This will not change the Vendor / Payee information in UAN.

**ID & Account #**
- Print ID & Account #: Saved. This setting brings data into the form from General → Maintenance → Vendor / Payees.
- Print ID & Account #: Override. Use this when you need to revise the 1099 form. This will not change the Vendor / Payee information in UAN.

**Other**
- Mark as Corrected. Marking will fill in the corresponding box on the 1099- Misc and open fields to enter the corrected name and Original ID / Name.
- Mark as 2nd TIN not. Marking will fill in the corresponding box on the 1099- Misc.

**Amounts**
- Print Amounts: Calculated. Box 3 will include the total year’s payments posted to the vendor in UAN. All other boxes are blank by default.
- Print Amounts: Override - use this when it is necessary to override any calculated amount.

UAN cannot provide tax advice on whether you should override any Box calculations/defaults. Please review IRS instructions for this form at [https://www.irs.gov/pub/irs-pdf/i1099mec.pdf](https://www.irs.gov/pub/irs-pdf/i1099mec.pdf) and if necessary, contact the IRS or a tax advisor.

*Other buttons below the 1099-Misc & 1096 Forms area:*

**Delete** Click to remove any vendor on the list in error or if you are replacing it with a new form.

**Print 1099** Click to print the marked vendors. Make sure to load blank 1099-Misc forms.

**Print 1096** Click to print the marked vendors. Make sure to load a blank 1096 form.

**File** Create a file for upload. Instructions follow on the next page.
CREATE A 1099-MISC FILE FOR UPLOADING

The IRS includes an option for filing 1099-Misc forms electronically. Review the IRS webpage ‘Filing Information Returns Electronically (FIRE)’

https://www.irs.gov/FIRE

This webpage is current as of the Year End Procedures print date.

Create the file with UAN:
- Available beginning with the filing year 2020 and following years only.
- After you finish adding and editing vendor 1099-Misc forms in UAN, select all vendors that you will be submitting the IRS information.
- Click File and read the message carefully. Click OK to continue and a form will open:

- A Transmitter Control Code (TCC) is required to transmit the returns. Review the IRS FIRE System webpage about this requirement.
- Confirm or fill in all required fields and click Save. Note the file name and location:

- Review the IRS FIRE System webpage for steps to upload the file.
UAN Menu: Payroll ➔ Reports & Statements ➔ External Forms ➔ 1095 & 1094 Forms to open the area. If needed, change the Year to 2021.

The majority of UAN clients may not be required by the IRS to complete the 1095 or 1094 forms, but it is very important that you determine any requirement for your particular entity and comply if necessary. UAN Support can ONLY provide technical software assistance for using the 1095 & 1094 area, but CANNOT provide instructions or advice on whether the form applies to your entity or the content entered on the form.

Per the IRS, only Applicable Large Employers (ALEs) and Self-Insured Coverage (SIC) providers must file 1095 and 1094 forms. ALEs are entities with 50 or more full-time employees – including full-time-equivalent (as determined by IRS guidelines) employees. A SIC provider healthcare plan is one in which the entity is responsible for paying the claims of the healthcare provided to the individuals enrolled in the plan. This does not include plans where the entity pays an insurance company the premiums for healthcare coverage and the insurance company is responsible for paying the claims of the individuals enrolled in the plan.

Again, UAN Support CANNOT determine if your entity fits these requirements. For guidance, call the Internal Revenue Service or visit www.irs.gov. You may find the following specific IRS web pages helpful. The first is a special IRS webpage set up to help employers comply with the Affordable Care Act reporting requirements https://www.irs.gov/Affordable-Care-Act/Employers

Below are IRS instructions for the specific forms:

As you review the above IRS publications, consider the following questions:
• Is your entity an Applicable Large Employer (ALE)? If you are not sure, do you have 50 or more employees? If you do not have 50 or more employees, your entity is not ALE. If you have 50 or more employees, you will need to use the calculation provided on the IRS website to determine whether your entity is an ALE. The IRS calculation website is: https://www.irs.gov/Affordable-Care-Act/Employers/Determining-if-an-Employer-is-an-Applicable-Large-Employer
• Is the insurance your entity offers considered a self-insured plan? If so, does your entity offer Individual Coverage Health Reimbursement Arrangements (ICHRA) or a traditional HRA plan?

Skip the 1095 & 1094 forms ONLY IF you are confident that – based on the IRS guidance – the entity is not an ALE and does not offer insurance that the IRS considers a self-insured plan.
USING THE 1095 & 1094 FORMS AREA

The IRS has authorized using UAN for printing these forms to plain paper. Because it is likely that only a minority of UAN clients will be required to complete the 1095 & 1094 forms, instructions for using this area are not included in this booklet. Instead, UAN provides instructions for each possibility that may be required of your entity in the UAN Payroll Manual. To view the instructions, go to UAN Menu: Payroll → Reports & Statements → External Forms → 1095 & 1094 Forms to open the area. When open, click the FAQs menu link ‘1095 & 1094 Forms’ in the lower-left corner of the screen.
**UAN no longer produces the rarely used Form 944 Federal Annual Tax Return.**

You must file annual Form 944 instead of filing quarterly Forms 941 only if the IRS notified you in writing. Form 944 is designed so the smallest employers will file and pay federal taxes only once a year instead of every quarter. For all questions about which forms your entity should file, contact the IRS or visit [https://www.irs.gov](https://www.irs.gov).

Information for completing a 944 form is available on the 2 federal tax reports listed below* (using the “Year” date selection) in Payroll → Reports & Statements → Tax Reports – Federal. The “YTD Total” rows show the corresponding totals for the 944.

<table>
<thead>
<tr>
<th>944 Form</th>
<th>* Federal Tax Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wages, tips, other compensation</td>
<td>Wages Subject to Federal / State / School Tax YTD</td>
</tr>
<tr>
<td>Taxable social security wages (Column 1)</td>
<td>Wages Subject to Social Security Tax YTD</td>
</tr>
<tr>
<td>Taxable Medicare wages &amp; tips (Column 1)</td>
<td>Wages Subject to Medicare Tax YTD</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>944 Form</th>
<th>* 941 Schedule B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal income tax withheld...</td>
<td>Federal YTD + Federal Supplemental YTD</td>
</tr>
<tr>
<td>Monthly tax liability (only if required)</td>
<td>Total for each month in Total column</td>
</tr>
</tbody>
</table>

Everything else on the 944 form calculates from these figures. Total deposits for the year are available on the Vendor Payment Register: General → Reports & Statements → Vendor / Payee Reports (for the federal payee).
This Appendix includes the following topics:

**Preparation & Review, starting on page 71**
- Verify W-2 employee setup & withholding information
- Confirm entity contact and tax ID information
- Online or disc submission registration (when applicable)
- Timing: determining when to print W-2 & W-3 forms
- Recommended review prior to processing W-2 forms

**Processing W-2 Forms, starting on page 74**
- Add W-2 forms
- Edit W-2 forms
- W-2 Editor (for box 12-14)
- Print W-2 forms overview
- Print W-2 forms
- Print the required ‘Notice to Employee’

**Processing W-3 Forms, starting on page 83**
- Print W-3 forms
- Create W-2 & W-3 Electronic Files

**Special Note For Clients That Converted To UAN Payroll Mid-Year, starting on page 90.**
Read these notes first if your entity converted to UAN Payroll mid-year.

---

**PREPARATION & REVIEW**

**VERIFY W-2 EMPLOYEE SETUP & WITHHOLDING INFORMATION**

Edits to the following employee and withholding areas will not automatically update 2021 W-2 forms if done in the work year 2022 and more time-consuming manual edits will be necessary. Save time by verifying and entering any needed corrections before closing the fiscal year 2021.

**Employee Information:**

**UAN Menu:** Payroll → Maintenance → Employees, select all employees, click Edit and Advanced. On the Employee Information Tab, verify the name, address, and Social Security number. The most common changes are due to employees moving or name changes during the
year. Clicking Save after a change will advance the form to the next employee record. When no changes are necessary, use the navigation arrows in the bottom left corner of the form to advance to the next record e.g.

Local Tax W-2 Abbreviations and School District numbers:
*UAN Menu* Payroll → Maintenance → Withholdings, select all Local and School tax withholdings, and click Edit. Verify that the W-2 Abbreviation is correct for all Local Taxes and the School District # is correct for all school district income taxes.

CONFIRM ENTITY CONTACT AND TAX ID INFORMATION

Entity Information:
*UAN Menu* General → Maintenance → Entity Setup. Verify or correct the Federal and State Tax IDs and the entity address listed. Unlike the Employee & Withholding information, you can edit these fields *before or after* closing the fiscal year 2021 and the information will be included on each employee’s W-2 form without manually editing.

ONLINE OR DISC SUBMISSION REGISTRATION (WHEN APPLICABLE)

If you are considering electronic file upload with the Social Security Administration (SSA) and/or intend to submit a CD to the Ohio Department of Taxation regarding W-2 / W-3 data, then review the requirements by those agencies as early as possible. For more information on how to use UAN in this process, see page 85 and following.

TIMING: DETERMINING WHEN TO PRINT W-2 & W-3 FORMS

It is technically possible to add, edit and print 2021 W-2 forms regardless of the login work year or whether the fiscal year is closed i.e. you can complete these tasks while logged into either 2021 or 2022 and complete them either before or after closing 2021. However, to ensure accuracy, please review the recommendations below.
RECOMMENDED REVIEW PRIOR TO PROCESSING W-2 FORMS

Before printing W-2s, ensure that year-to-date tax reports balance with the totals that will report on the W-2 forms by completing the steps that follow. **Note:** the only entities that will be able to produce accurate W-2 forms before closing the fiscal year 2021 are those that have no unresolved payroll issues and have a payroll schedule permitting the completion of the final wages, tax payments, and external withholding reports in December. Therefore, you may need to close the fiscal year before completing some of the steps below.

1) Research, identify, and resolve all 2021* unpaid withholdings and/or withholding overpayments that would affect the 2021 monthly/quarterly tax reports and W-2s.

   *Unpaid withholdings and withholding overpayments carried forward from years prior to 2021 will not affect the 2021 W-2 forms but will affect your 2022 budget.

   If there are any unresolved issues, UAN recommends reviewing the short video ‘Evaluate Unpaid Withholdings’. Click or enter the link below and scroll to ‘Housekeeping’.

   [https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html](https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html)

2) Finish posting all 2021 Wages.

3) Prepare December and/or 4th Quarter tax reports.

4) Pay 2021 tax liabilities (either in 2021 or in 2022, if carried over).

5) Complete the December bank reconciliation – it may reveal the need for correcting entries that could affect payments, external tax reports, and W-2s.

6) Make sure that the withholdings that will report on the W-2 forms will match those reported to the various withholding agencies when totaling the monthly or quarterly reports.

   **UAN Menu:** Payroll → Reports & Statements → Tax Reports – Federal. Select the **W-2 Report**. Select all employees in the list and click Print.

   The W-2 Report includes a ‘Report Totals’ section on the last page that includes the annual totals of the following taxes withheld (when applicable) from wages: **Federal Income Tax, Medicare, Social Security, Ohio Income Tax, School, and Local**. Investigate any discrepancies between the W-2 Report totals and actual amounts reported to the agencies.

   **Warning:** UAN Payroll properly applies the laws that govern taxes and retirement to calculate the taxes for wages, generate the tax reports, payments, and W-2s. If, after a thorough examination, you find that you or someone prior to taking office have **manually edited tax-related withholdings on wages** (Payroll → Transactions → Wages, Edit) and/or have erroneously (over or under) corrected items **contrary to tax rates and laws** then UAN support staff cannot assist in determining how to amend your reports, payments, and/or W-2 forms. In such cases, you may need to consult a tax professional.
PROCESSING W-2 FORMS

ADD W-2 FORMS

UAN Menu: Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms. Read the message and click OK. The W-2 & W-3 Forms tab will open to an empty list (unless employees were previously added). Please review the image below:

1. Select the Report Year. It is important to select the Report Year to the correct W-2 fiscal year before clicking the Add button. If you are working in the fiscal year 2021 the year 2021 will default in the box. If you are working in the fiscal year 2022, and you have posted wages in 2022, the year 2022 will default in the box. To select the correct fiscal year, click the Report Year menu.

2. Click Add and read the message:

As noted in the message, you will be able to manually edit W-2s or delete them to start over. However, the W-2 report will not reflect manual edits – it will continue to report the data from the actual payroll postings.
3. **Click OK** to continue. The Add W-2 Form opens and the upper left corner defaults to (active and inactive) employees “Paid This Year” for the fiscal year 2021 as seen in the screen that follows.

![Add W-2 Forms](image)

*Special Note for entities that joined UAN in 2021:* even if there are no posted wages in UAN it is still possible to use the software to create and edit W-2s – as long the employees have been added under Payroll → Maintenance. If this is the case, select **All Employees**.

4. **Select employees** that you would like to add to the W-2 Forms list at this time and **click Save**. A confirmation message will appear in the lower-left corner of the form. **Click Close** and the list will update.

---

**EDIT W-2 FORMS**

**Important Note:** the **W-2 report** will not reflect manual edits to the **W-2 forms** – it will continue to report the data from the actual payroll postings. Only the W-2 forms and the corresponding W-3 forms will reflect the edits. When edits are necessary, UAN recommends verifying that 941 reports and state, local, and school tax report totals balance with the corresponding W-3 report before issuing W-2 forms to employees. The taxing districts will compare your W-2 forms with the reports filed and payments made for 2021. If there is a discrepancy, they will require you to reconcile the items; therefore, UAN recommends that you reconcile and correct any errors before issuing the W-2 forms.

**Steps to Edit W-2 forms:**
After employee data has been added to the list, W-2 forms can be edited when necessary.

1. **Select the employee name and click Edit.** A message will open:
2. **Read and click OK.** Note: the message is explained in greater detail later in this booklet. The Edit W-2 Form will open as seen in the illustrated screen that follows.

3. **Edit** only when absolutely necessary. In most circumstances – when Payroll maintenance and transactions have been entered correctly throughout the year – there is no need to edit the W-2. Review the Edit W-2 Form Guide that follows a detailed explanation of form options.

4. **Click Save** after all edits are complete. If multiple employees were selected, the form will advance to the next employee. After all the employees selected are complete, **click Close**.

**Edit W-2 Form Guide:**

Review the illustrated screen that follows to familiarize yourself with the form layout.

First, double-check the Employer's address and Federal Tax ID in the bottom center of the form. As previously mentioned, the Employer information listed cannot be edited on the form itself. If any employer information is incorrect, review the instructions under the ‘Confirm entity contact and tax ID information’ notes starting on page 72 and then edit the W-2.

All **employee-specific** contact information can be overridden on the Edit W-2 Form only after the fiscal year 2021 is closed. Ideally, it is better to discover discrepancies before closing the fiscal year 2021 by completing the steps in ‘Preparation & Review’ (starting on page 71) so that you only have to enter updates one time – at the source – under Payroll → Maintenance → Employees.
The Edit W-2 Form is designed so that you can change employee information that will print on the W-2 while still being able to view the latest data that was created (calculated or saved) in the fiscal year 2021. The form is separated into sections and tabbed pages. Notice the employee sections in view when the form is first opened: Name, Details, Box 13, and Federal under the Federal tab. Each section includes either a ‘Saved’ or ‘Calculated’ area and an Override button that will enable edits. To make changes in any section, select the corresponding Override button and edit the items you wish to change in the override area; the original data cannot be changed, but when the Override button is selected, only the data in the override area will print on the W-2. All sections that do not have Override selected will print the latest data that was created (calculated or saved) in the fiscal year 2021.

For example, in the screen that follows, notice that the Federal section defaults to ‘Print Federal Calculated’, but it can be changed to ‘Print Federal Override’. Selecting the ‘Print Federal Override’ button will duplicate the amounts listed in the ‘Print Federal Calculated’ column. Type over any amounts in the override column that need to change and those amounts will be printed on the W-2 instead of the calculated amounts.

The State & Box 12 tab and the Local & Box 14 tab include sections for the UAN calculated data and areas to override that data *when necessary*. Review the illustrated screens that follow.
State & Box 12 tab is selected on this screen.

Local & Box 14 Tab is selected on this screen.

When selecting Override, the original data is duplicated into the override area. You can **edit** the existing override lines, **delete** lines by clicking an X next to the row or use a data entry line to **add** new lines. Clicking Save will advance the screen to the next employee. Continue until you have
completed reviewing and (when necessary) editing other W-2s. Click Close to exit the form. Keep the W-2 & W-3 Forms area open when you are ready to print.

**W-2 EDITOR**

The W-2 Editor is an optional tool for quickly adding or editing data in W-2 boxes 12, 13, and 14 for multiple employees at a time. Instructions are included in the UAN Payroll Manual. To access the W-2 Editor instructions go to Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms. Read the message and click OK. In the bottom left corner, under the FAQs menu, click the ‘W-2 Editor’ link and the manual will open to the instructions.

**PRINT W-2 FORMS OVERVIEW**

**UAN will ONLY print W-2 & W-3 forms on plain blank paper.** When printed from UAN, the forms meet the Social Security Administration’s (SSA) 2021 plain paper requirements. In addition to saving money, plain paper printing prevents various printer alignment issues that are often encountered with pre-printed forms.

W-2 print options available in UAN:

<table>
<thead>
<tr>
<th>EMPLOYER</th>
<th></th>
<th>EMPLOYEE</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 employees per page</td>
<td>2 employees per page</td>
<td></td>
</tr>
<tr>
<td>4 employees per page</td>
<td>1 employee per page</td>
<td></td>
</tr>
<tr>
<td><strong>PART</strong></td>
<td><strong>PART</strong></td>
<td><strong>PART</strong></td>
</tr>
<tr>
<td>Copy A</td>
<td>Federal (SSA)</td>
<td>Copy B</td>
</tr>
<tr>
<td>Copy D</td>
<td>Employer Records</td>
<td>Copy C</td>
</tr>
<tr>
<td>Copy 1</td>
<td>State / City / Local</td>
<td>Copy 2</td>
</tr>
<tr>
<td>Copy 1</td>
<td>State / City / Local</td>
<td>Copy B + C + 2 + 2</td>
</tr>
</tbody>
</table>

Optional: **perforated** plain blank paper purchased from third-party vendors may be used. The styles compliant with UAN software are the 2-Part (2-up) sheets with one horizontal perforation (2 per sheet), and the 4-Part (4-up) sheets with three horizontal perforations (4 per sheet).
**UAN Menu:** Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms. Read the message and click OK. Select 2021 from the Report Year menu. Select all of the employees from the list and click the Print W-2 button and the Print W-2 Form will open.

**Form Options:**

- **W-2 Copy buttons:** select to print *one copy type at a time* i.e. print one set of W-2 copies for the selected group of employees before moving on to the next set of W-2 copies.
- There is no required order for printing the W-2 copy types. For example, all Copy D forms could be printed before printing Copy A forms or visa versa.
- **Order by: Name or SSN:** At the bottom of the form, you may select to sort the W-2 copies by employee name or by social security number. You do not have to use the same setting for all W-2 copy types.
- **Important:** blank paper printing of W-2 forms requires printing a separate ‘Notice to Employee’ page to include with each employee W-2 form. Instructions start on page 82.
- For any employees whose withholding information cannot fit onto a single W-2, extra copies will print automatically (omitting certain redundant information, as specified by the form instructions).

**Copy A – Social Security Administration (SSA) Requirements:**

- **SSA Electronic filing options:** Entities that have registered with the SSA to upload an electronic W-2 and W-3 file do not need to print the Employer Copy A: Federal (SSA).
  - Instructions to create the electronic file start on page 85.
- **SSA Paper Reporting Requirements:** the SSA requires that Copy A of the forms W-2 (and the W-3) be separated into MQGE and 941/944 batches for paper reporting.
  - MQGE employees are defined as those with Medicare + OPERS / OP&FPF deductions and 941 / 944 employees as everyone else.
  - The software will automatically print Copy A in separate batches.
  - Be prepared to pair each W-3 with its corresponding W-2 batch for mailing.

**Copy 1: State / City / Local – Special Considerations:**

Employers may be required to submit Copy 1 for State Tax withholdings and (when applicable) to any withholdings for school tax or local tax agencies. A separate Copy 1 must be printed to submit to each tax district as required by those agencies. Entities that are required to file a monthly or quarterly report for school or local taxes will also be required to submit an annual reporting form along with Copy 1. UAN staff cannot provide any further guidance on specific tax district filing requirements – contact the tax district for instructions and obtain their annual forms.
**PRINT W-2 FORMS**

**Important:** Read the Print W-2 Forms Overview (if you have not already) before continuing.

**Time-Saving Tip:** if possible, print all W-2 Copy sets before exiting the Print W-2 form.

**Explanation:** the first group of W-2 forms sent to the printer takes longer because it triggers temporary calculation that will be used for all W-2 copies that will be printed while the Print W-2 form is open. If the Print W-2 form is closed and reopened, the software will have to repeat the temporary calculation when the next group is selected for printing.

**Printing Instructions for W-2 Forms – Copy B, C, D, and Copy 2:**

1. Select a W-2 Form Copy type to print.
2. Confirm or change the sort ‘Order by’ button selected i.e. order employees by name or SSN.
3. Verify that you have the correct paper in the printer tray.
4. Click OK and then click Print when the printer message opens.
5. Repeat the steps above until all needed Employee and Employer sets print for these copy types.

**Printing Instructions for W-2 Forms – Copy A:**

1. Select W-2 Form Copy A type to print.
2. Confirm or change the sort ‘Order by’ button selected i.e. order employees by name or SSN.
3. Verify that you have the correct paper in the printer tray.
4. Click OK to print.

The steps that follow (a. or b.) will depend on the group of employees selected:

a. When the employees selected include **only one type** (MQGE or 941/944), then the software will automatically send the W-2 forms in one batch to be printed.
   i. Click Print when the printer message opens.

b. When the employees selected include **both types** (MQGE and 941/944), then the software will automatically print the W-2 forms in two separate batches.
   i. Read the first message (also explained in the Print W-2 Forms Overview) and click OK and a second message will open.
   ii. Read the second message and decide ‘Should UAN pause printing between each group of Copy A forms?’ Decide and click Yes or No.
      • If No was selected, UAN will print both groups without pausing.
         o Click Print when the printer message opens.
      • If Yes was selected, then you will have to click OK to resume printing after the first group prints.
         o Click Print when the printer message opens. The first group of Copy A forms will print and a message will appear.
         o After you remove and set aside the first group of Copy A forms, click OK to print the second group of Copy A forms.
Printing Instructions for W-2 Forms – Copy 1:

1. Select a W-2 Form Copy 1 type to print (2 part or 4 part employer). A vendor list menu will open below the button. It will only include options for the state, school, and local tax agencies that apply to the group of employees selected for printing.
2. Select one tax agency from the menu.
3. Confirm or change the sort ‘Order by’ button selected i.e. order employees by name or SSN.
4. Verify that you have the correct paper in the printer tray.
5. Click OK and then click Print when the printer message opens.
6. Repeat the steps above to print Copy 1 forms for each tax district as required by those agencies.

PRINT THE REQUIRED ‘NOTICE TO EMPLOYEE’

All W-2s issued on blank paper must be accompanied by a Notice to Employee. You can print the Notice to Employee from the W-2 & W-3 Forms page.

UAN Menu: Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms, the W-2 & W-3 Forms tab will open. Read the message and click OK. Select 2021 from the Report Year menu. Click the Print Notice button (as seen below) and the Print form will open. On the Print form, select the number of copies you need, and click Print.
PROCESSING W-3 FORMS

PRINT W-3 FORMS

**UAN Menu:** Payroll → Reports & Statements → External Forms → **W-2 and W-3 Forms.** Read the message and click OK. Make sure 2021 is in the Report Year box. Select all of the employees from the list and click the Print W-3 button. A message will open:

![System Message](image)

Read the message and click OK. The Print W-3 form will open. Most of the information on the W-3 form is automatically generated based on the W-2 totals of the employees selected and therefore cannot be directly edited on the W-3. The exceptions include the list of items that follow. Note: the UAN default (amount or setting) of the items listed should be carefully reviewed and changed when necessary.

1) **Kind of Employer:** State/local non-501c or State/local 501c.
   The setting is located at the top-left of the form. Select the type applicable to your entity. Click the blue question mark (?) for more information. If necessary, contact the IRS for assistance; UAN staff cannot answer questions about the selection.

2) **Employer Information, Federal Tax ID & State Tax ID:** confirm accuracy. If corrections are necessary, close the ‘Print W-3’ form and go to General → Maintenance → Entity Setup to edit. Save, close, and then return to the ‘Print W-3’ form which will now include the corrections.

3) **Kind of Payer** federal tax report type: 941 Quarterly or 944 Annual (if available).
   The setting is located at the top-right of the form. Select the type applicable to your entity.

4) **Total number of forms W-2 (Override) – only use if necessary.**
   In the first row in the table, the total number of W-2 forms for the W-3 will automatically calculate. Some employees may generate more than one W-2 Form. Only edit this field when necessary.
5) **Box 14: Income tax withheld by payer of third-party sick leave — when applicable.**

If the entity has income tax withheld by a payer of third-party sick pay, enter the total in this field. UAN staff cannot answer questions about third-party sick pay.

**Note:** the line for ‘Local wages’ is the total of all Local wages lines from the included W-2s. This ties the forms together. For example, if an employee earned $10,000 subject to school tax and a village tax, the W-3 Local wages line sums it to $20,000.

After confirming all items on the form are accurate, click OK to print. When the selected employees include both types (MQGE and 941/944 types), then the software will open the message that follows. Otherwise, it will skip to a print form.

When applicable, read the message and click OK to continue. A print form will open. Select the printer and click Print. The following message will open while the W-3 form(s) print:

**Important:** this is something that only you can confirm. The tax districts will use your year-to-date tax deposits and/or reports to compare the W-2 forms for accuracy. This final review is especially important when you have edited wages, withholdings, or other items on any W-2 form. Make sure the W-3 generated by the W-2 forms balance with year-to-date tax report totals. If they do not balance with the reports and taxes that have been paid then the respective tax agencies will contact you for an explanation of the discrepancy. Click OK to close the message.
CREATE W-2 & W-3 ELECTRONIC FILES (IF REQUIRED OR PREFERRED)

UAN can create the following electronic files for submission:

- **Social Security Administration (SSA): W-2 & W-3 Federal Tax Filing:** Create a file containing W-2 & W-3 data that you can upload through the SSA website for the entity’s federal tax filing i.e. in place of mailing W-2 Copy A and W-3 forms to the SSA. The entity must first register for electronic file upload with the Social Security Administration (SSA) before you can use this feature in UAN. Note: UAN Staff cannot assist with the registration.

- **Ohio Department of Taxation: W-2 Ohio & School District Tax Filing.** Create a file containing W-2 data for submission of Ohio and (if applicable) school district tax reporting i.e. in place of mailing W-2 Copy 1 forms. The Ohio Department of Taxation (ODT) provides a means to upload W-2 data using an online feature in Ohio Business Gateway (OBG). This is ODT’s preferred method for receiving the file. **New requirement threshold:** ODT released a tax alert, lowering the threshold of when employers are required to electronically file W-2 data. Beginning with calendar year 2021 information, all employers that issue 10 or more W-2s are now required to upload W-2 information electronically through the Ohio Business Gateway.
  - You can open ODT instructions from their ‘W-2 /1099 Information Page’
    *This webpage is current as of the Year End Procedures print date.* Click ‘2021 W-2 Upload Specifications’ and page 4 provides submission steps.
  - UAN staff can only answer questions applicable to creating and saving the data file to the UAN computer hard drive (instructions follow). The UAN steps will create the file in the EFW2 format that ODT requires. Please contact the Ohio Department of Taxation regarding all other questions about their online submissions.

**Note:** UAN cannot create electronic files in place of W-2 Copy 1 forms for local or city tax reporting requirements.

**Recommendation:** print the applicable W-2 & the W-3 forms for in-office use even though it is not necessary for the SSA or the Ohio Department of Taxation when an electronic file is used. Complete the electronic file steps only after you have verified the accuracy of the printed forms.

**Special Note for entities with school tax withholdings:** school tax withholdings must be set up using the proper UAN processing group code to be included in the Ohio + Schools W-2 upload file. Before proceeding, verify that all relevant school taxes are set up as process group “G00 – School Tax” in Payroll ➔ Maintenance ➔ Withholdings (under the Process Group column). If any school withholdings were set to an incorrect process group, contact UAN Support for assistance to correct the problem before creating the Ohio + Schools upload file.
**UAN MENU:** Payroll ➔ Reports & Statements ➔ External Forms ➔ W-2 and W-3 Forms, the **W-2 & W-3 Forms** tab will open. Select Report Year 2021. Select all of the employees in the list and click **File**.

You will receive the following message:

![System Message]

**Read** the message and click **OK**. The File W-2 and W-3 form opens.

Most of the information on the File W-2 and W-3 form is automatically generated based on the W-2 totals of the employees selected and therefore cannot be directly edited in this form. The exceptions include the list of items that follow. Note: the UAN default (amount or setting) of the items listed below should be carefully reviewed and changed when necessary.

1) **Kind of Employer:** State/local non-501c or State/local 501c.  
The setting is located at the top-left of the form. Select the type applicable to your entity. Click the blue question mark for more information. If necessary, contact the IRS for assistance; UAN staff cannot answer questions about the selection.

2) **BSO User ID:** Enter the BSO (Business Services Online) User ID assigned by the Social Security Administration. The entity must be registered with the SSA to file electronically. Contact the SSA with questions about this.  
**☐ Resubmit WFID** (Wage File Identifier): Leave this checkbox unmarked for the initial submission. In a situation where you need to resubmit, you will need to enter a WFID supplied by the Social Security Administration. UAN cannot provide this information.

3) **Employer Information, Federal Tax ID & State Tax ID:** confirm accuracy. For filing purposes, you can edit all employer fields except federal and state tax IDs. To correct tax IDs or to enter permanent corrections, cancel the ‘File W-2 and W-3’ form and go to General ➔ Maintenance ➔ Entity Setup to edit. Save, close, and then return to the ‘File W-2 and W-3’ form which will now include the corrections.

4) **Kind of Payer** federal tax report type: 941 Quarterly or 944 Annual (if available).  
The setting is located at the top-right of the form. Select the type applicable to your entity.
5) **Box 14: Income tax withheld by payer of third-party sick leave – when applicable.** If the entity has income tax withheld by a payer of third-party sick pay, enter the total in this field. UAN staff cannot answer questions about third-party sick pay.

**Note:** the line for ‘Local wages’ is the total of all Local wages lines from the included W-2s. This ties the forms together. For example, if an employee earned $10,000 subject to school tax and a village tax, the W-3 Local wages line sums it to $20,000.

After completing the form, select the ‘**Federal (SSA)**’ from the menu:

![Menu Selection](image)

Click **OK**. The following message will open:

![System Message](image)

**Recommended:** click **Yes** and then click **OK** when the Print form opens to print the report. Whether selecting Yes or No, the message that follows will open.

![System Message](image)

The electronic file is ready for upload to the SSA. **Reminder:** mailing forms W-2 and W-3 to the SSA is not necessary when you have chosen to upload the electronic file. Contact SSA if you need assistance with the upload process.

Click **OK** and select the ‘**Ohio + Schools**’ from the menu:
Click **OK** and the following message will open:

![System Message]

Read the message. If the entity has school tax withholdings and you have not confirmed this information yet, then follow the instructions to verify before proceeding with a file upload.

Click **OK** and the following message will open:

![System Message]

_Recommended:_ click **Yes** and then click **OK** when the Print form opens to print the report. Whether selecting Yes or No, the message that follows will open.
Click OK. The electronic file is ready for upload to the Ohio Department of Taxation through Ohio Business Gateway. **Reminder:** mailing form W-2 Copy 1 for Ohio and School Taxes is not necessary when you have chosen to upload the electronic file. Contact the Ohio Department of Taxation if you need assistance with the upload process.

After confirming that the ‘W2 SSA Upload 2021’ and ‘W2 Ohio Upload 2021’ files transmit successfully, delete them under C:\_UAN_EFiles and then empty them from your computer’s Recycle Bin.

**Important:** the ‘W2 SSA Upload 2021’ and ‘W2 Ohio Upload 2021’ contain sensitive employee data in which there can be no encryption and therefore the information is not secure in cases of unauthorized computer access, virus, or malware infection. UAN is initially set up to delete these files automatically after a set number of hours in the event you accidentally leave one undeleted. You can confirm this setting under General ➔ Maintenance ➔ Entity Setup and click the System tab. For more information, click the 🕵️‍♂️ icon in the ‘Sensitive Unsecured UAN Efiles’ section of the form.
SPECIAL NOTE FOR CLIENTS THAT CONVERTED TO UAN PAYROLL MID-YEAR 2021

Entities that began using UAN Payroll during the fiscal year 2021 had multiple choices to convert their previously posted 2021 payroll data into UAN. Before the close of 2021, you still have time to add employees and post conversion wages to bring your prior payroll ledger balance into UAN for W-2 printing. Review the following items to determine how to prepare for the 2021 W-2s:

- If you added all employees that were paid in the fiscal year 2021 and posted all the conversion wages to bring the year-to-date ledger balance into Payroll, you can print forms W-2 and W-3 as normal.

- If you added all of your 2021 employees to Payroll and began posting wages, but did not post a conversion wage you have the following three options:
  A. **Prior to closing 2021**, you can post conversion wages to bring your prior payroll ledger balance into UAN, and then print the forms W-2 and W-3 as normal.
  B. Add a W-2 for the employees and edit the figures to report the combined total of the wages paid from your prior payroll ledger and the UAN posted Payroll, and then print the forms W-2 and W-3 as normal.
  C. Manually prepare your forms W-2 and W-3, combining the UAN posted payroll data and old payroll ledger balance.

- If you did not add all of your 2021 paid employees into Payroll and post conversion wages for them before the fiscal year 2021 is closed:
  - Manually prepare your forms W-2 and W-3, combining the UAN posted payroll data and old payroll ledger balance.

- If you added all of your employees to UAN Payroll but did not post a conversion wage or any live wages in the software, **then before the fiscal year 2021 is closed**:
  - Post conversion wages for all employees from your payroll ledger and print the W-2 and W-3 reports. OR
  - Manually prepare your forms W-2 and W-3 (i.e. outside of the UAN Payroll).

- Note: The W-3 form will compile the data from the selected W-2s in the software, including any edits you have made to the W-2s, but the W-3 cannot be edited to include any manually prepared W-2s.
When you open Temporary Mode in 2021 you will be able to log into the work year 2022. During Temporary Mode, you may select the work year upon login. See below:

Although you will be able to log into the work year 2022 to begin your new year accounting procedures, you must pay particular attention to the effective date of the changes. The lists below contain brief instructions on how to complete the steps. For detailed information, follow the UAN Menu listed to open a particular area, and then click ‘Need Help?’ on the main menu for screen-specific information. Also, some areas include links to helpful screencast video tutorials located under the FAQs menu in the lower-left corner of the UAN screen.

**REMOVE OR DEACTIVATE ITEMS NO LONGER NEEDED**

The beginning of the year can be a good time to ‘clean house’ in the software to easily remove or deactivate items that will not be needed in the future. Some items may not be removable, but you can deactivate them. For example, you cannot remove appropriation accounts used on carryover purchase orders even though they will not be necessary for future activity after you post the final payment in the new year. If desired, you can deactivate them so that they will not display in transaction menus and certain reports. Deactivating an item will not affect transactions posted prior to deactivating. For example, deactivating an account used on a carryover purchase order will not prohibit you from making a payment using that purchase order, but will prevent you from selecting that account when creating a new purchase order.

**Recommendation:** Using filters in the areas below can save time. In the maintenance areas, click the ‘Status’ menu. In the reports areas, click the ‘Filters’ tab.

**Remove or deactivate funds, revenue, and appropriation accounts**

When the year is closed, the revenue and appropriation budgets are set to zero while the revenue and appropriation accounts carry to the new year. Note: the order below is important because you cannot remove funds until after removing all revenue and appropriation accounts in that fund.
<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove or deactivate unneeded revenue accounts</td>
<td>Accounting ➔ Maintenance ➔ Revenue Accounts</td>
</tr>
<tr>
<td>To review the account list, print the Revenue Chart of Accounts</td>
<td>Accounting ➔ Reports &amp; Statements ➔ Revenue Reports</td>
</tr>
<tr>
<td>Remove or deactivate unneeded appropriation accounts</td>
<td>Accounting ➔ Maintenance ➔ Appropriation Accounts</td>
</tr>
<tr>
<td>To review the account list, print the Appropriation Chart of Accounts</td>
<td>Accounting ➔ Reports &amp; Statements ➔ Appropriation Reports</td>
</tr>
<tr>
<td>Remove or deactivate unneeded funds</td>
<td>Accounting ➔ Maintenance ➔ Funds</td>
</tr>
<tr>
<td>To review the account list, print the Fund Chart of Accounts</td>
<td>Accounting ➔ Reports &amp; Statements ➔ Fund Reports</td>
</tr>
</tbody>
</table>

**Delete or deactivate Vendors / Payees**

You can only delete a vendor if there have never been any cash transactions with the vendor and no current encumbrances are using the vendor. You can deactivate all other vendors that will not be necessary for future transactions.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove or deactivate unneeded Vendors / Payees</td>
<td>General ➔ Maintenance ➔ Vendors / Payees</td>
</tr>
<tr>
<td>To review the vendor list, print the Vendor / Payee Listing</td>
<td>General ➔ Reports &amp; Statements ➔ Vendor / Payee Reports</td>
</tr>
</tbody>
</table>

**ADD NEW MAINTENANCE ITEMS**

**ADD NEW ACCOUNT CODES AND VENDORS**

Add new items (if needed) to be used in 2022.

**Note:** If you make use of cost centers (optional), you should add them before adding revenue and appropriation accounts.
Add new funds, revenue, appropriation accounts, and vendor/payees.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Add new funds</td>
<td>Accounting ➔ Maintenance ➔ Funds</td>
</tr>
<tr>
<td>☐ Add new cost centers (if used)</td>
<td>Accounting ➔ Maintenance ➔ Cost Centers</td>
</tr>
<tr>
<td>☐ Add new revenue accounts</td>
<td>Accounting ➔ Maintenance ➔ Revenue Accounts</td>
</tr>
<tr>
<td>☐ Add new appropriation accounts</td>
<td>Accounting ➔ Maintenance ➔ Appropriation Accounts</td>
</tr>
<tr>
<td>☐ Add new vendors/payees</td>
<td>General ➔ Maintenance ➔ Vendors / Payees</td>
</tr>
</tbody>
</table>

ADD REVENUE BUDGETS

Add 2022 revenue budgets for each fund. The entity will not be able to appropriate more than the January 1 cash balance in each fund until after entering the revenue budget. Another reason this needs to be accurately completed is so that the 2022 annual financial reports will be correct.

The revenue budget is an estimate of an entity’s anticipated revenue from taxes and other sources during the year. The total per fund of each revenue budget should equal the tax revenue and other sources on the Certificate of Estimated Resources provided by the County Budget Commission.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Add revenue budgets</td>
<td>Accounting ➔ Maintenance ➔ Revenue Budgets, then click Add</td>
</tr>
<tr>
<td>☐ Print the Resources Available for Appropriation</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Budgetary Reports</td>
</tr>
<tr>
<td>☐ Confirm the Estimated Revenue column for each fund matches the total of the ‘Taxes’ and ‘Other Sources’ columns for each fund on the most recent 2022 Amended Certificate of Estimated Resources from the budget commission.</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Budgetary Reports</td>
</tr>
<tr>
<td>☐ Print the Revenue Status to confirm you entered individual amounts correctly.</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Revenue Reports</td>
</tr>
</tbody>
</table>
ADD APPROPRIATION BUDGETS

Add 2022 appropriation budgets for each fund. You cannot record new purchase orders and payments until after entering appropriation budgets.

An appropriation budget is an amount that the entity expects to spend on each appropriation account (line item) for the year. If needed, a temporary appropriation ordinance to control expenditures may be adopted on or about January 1 of each year, for the period January 1 to March 31. The temporary appropriation budget amounts can be an estimate of what will be spent for up to the first three months. An annual appropriation ordinance must be adopted by April 1 of each year, for the period January 1 to December 31. The permanent appropriation budget amounts must be an estimate of what will be spent for the entire year.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Add appropriation budgets</td>
<td>Accounting → Maintenance → Appropriation Budgets, then click Add</td>
</tr>
<tr>
<td>☐ Print the Appropriation Status to confirm individual amounts were entered correctly</td>
<td>Accounting → Reports &amp; Statement → Appropriation Reports</td>
</tr>
<tr>
<td>☐ Print the Comparison of Budget and Appropriation</td>
<td>Accounting → Reports &amp; Statement → Budgetary Reports</td>
</tr>
<tr>
<td>☑ Confirm the Final Appropriation amount for each fund equals the fund subtotals on the appropriation ordinance. The Variance column should be zero or positive for each fund.</td>
<td></td>
</tr>
</tbody>
</table>

If the variance amount listed is negative, then your Final Appropriation budget in UAN exceeds the amount of Total Estimated Resources for that fund. Double-check for data entry errors by reviewing the Appropriation Status and Revenue Status reports. If there are no data entry errors in the revenues or appropriations inputted in UAN, then it appears your entity is stating on the Appropriation Ordinance / Resolution that it is planning to spend more than the total available resources for that fund as stated on the latest Amended Certificate of Estimated Resources.

This situation should be resolved – consult with the board/council to discuss a resolution and/or consult with the county auditor.
**ADD NEW INVESTMENTS**

Add any new investments for the year.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add new investment account information under Accounting → Maintenance → Investments and click Add. Click Save when finished and repeat for each investment.</td>
<td>Accounting → Transactions → Purchase Orders</td>
</tr>
<tr>
<td>Upon closing the investment form, UAN will prompt to print a new investment report. Click Yes to print.</td>
<td>Accounting → Reports &amp; Statement → Purchase Order Reports</td>
</tr>
<tr>
<td>Then UAN prompts you to open the Investment Transfer form. Click Yes or to open it later go to Accounting → Transaction → Investment Transfer.</td>
<td>Accounting → Reports &amp; Statement → Purchase Order Reports</td>
</tr>
<tr>
<td>Upon closing the investment transfer form, UAN will prompt to print an investment transfer report. Click Yes to print.</td>
<td>Accounting → Reports &amp; Statement → Purchase Order Reports</td>
</tr>
</tbody>
</table>

**ADD NEW PURCHASE ORDERS**

To make payments using appropriations in the new year’s budget you will need purchase orders detailing the authorization and commitment to purchase goods or services.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Add and select the type of purchase order. Or, if you tend to use similar purchase orders from year to year, consider using the Duplicate button. For instructions, click ‘How To Duplicate Purchase Orders’ under the FAQs menu when the Purchase Orders area is open.</td>
<td>Accounting → Transactions → Purchase Orders</td>
</tr>
<tr>
<td>Print the Purchase Order Status</td>
<td>Accounting → Reports &amp; Statement → Purchase Order Reports</td>
</tr>
</tbody>
</table>

**BEGIN 2022 TRANSACTIONS**

You can now begin posting 2022 accounting transactions.

**Note:** If you had recorded any 2022 transactions manually (not using the UAN application) before you opened Temporary Mode or closed the year, then enter those transactions in UAN in the exact sequence, date-by-date until all are recorded. Then begin new transactions.
When you open Temporary Mode in 2021 you will be able to log into the work year 2022. Temporary Mode allows you to work in both fiscal years 2021 and 2022 before closing the fiscal year 2021, which provides many potential advantages. Opening Temporary Mode is a required step in the year end process, but working in 2022 before closing 2021 is completely optional. During Temporary Mode, you may select the work year upon login. See below:

Although you will be able to log into the work year 2022 to begin your new year payroll procedures, you must pay particular attention to the effective date of the changes.

For example, local and school tax rates become effective January 1. Therefore, a new withholding for the local or school tax must be added and then added to each employee before the first wages are posted in the new year. A change to the rate of an existing local or school tax must be edited to the new rate and the employees updated (using the Withholding Editor) before the first wages are posted in the new year.

Likewise, you may have employees that receive pay increases or leave balance adjustments that take effect on January 1. Before you update the employees in the work year 2022 make sure you will be posting a pay period that includes the effective date of these local policy items. Review the last section of this appendix for important considerations before completing leave adjustments.

The following pages contain brief instructions about each subject. For detailed information, follow the UAN Menu provided to open the form or list and then click ‘Need Help?’ on the main menu for screen-specific information. Also, some areas include links to helpful screencast video tutorials located under the FAQs menu in the lower-left corner of the UAN screen.

**UPDATE MAINTENANCE ITEMS**
Add New Additional Information *(optional: UAN does not require you to use this)*
Payroll → Maintenance → Additional Information, click Add
- Enter the name of the new item, the description, set the display order, and mark the desired sensitivity level.
- Click Save and Close

Add New Earnings or Leave
Payroll → Maintenance → Earnings and Leave, click Add
- Enter a new Earning/Leave Name (must be different than existing items)
- Select the Type and the OP&FPF Type (applies to OP&FPF Employers only)
- Save & Close
Go to Payroll → Maintenance → Employees to Edit an individual employee and then add the new item. Edit and add the item to each applicable employee.

Add New Withholdings
Does the new withholding require a new payee in UAN? Or is there one that you can use?

**Add the payee when necessary**: General → Maintenance → Vendors/Payees click Add
- Enter Name of the payee
- Mark ☒ Payroll Withholding
- Enter account #1
- Add location if necessary
- Save & Close the Location form and then Save & Close the Vendor/Payee form

If the payee is already available to use in UAN or after adding a new one:

**Add the Withholding**
Payroll → Maintenance → Withholdings, click Add
- The Name must be different than existing items
- Select the Process Group
- Select the Payee
- Complete all applicable fields in the Details tab.
- Save* and Close.

*Note: if you pick a Process Group type A00 or B00, UAN will provide a series of messages to help you determine whether you selected the correct type.

Go to Payroll → Maintenance → Employees to Edit an individual employee and then add the new withholding. Edit and add the withholding to each applicable employee.

Update Withholding Rates
Update rates in the main withholding list: Payroll → Maintenance → Withholdings
- Mark the withholding and click Edit.
- Update the rate or amount to the new rate. Click Save and Close.
Update rates for withholdings assigned to employees. Payroll → Maintenance → Withholdings Editor
- Select the withholding and mark all employees to be updated to the new rate.
- Enter the new rate or amount in the ‘Change To’ section of the form.
- Click Save and confirm the value has changed in the list. Click Close.

Update Skip Calendars (when applicable)
Add & Apply Skip Calendars in Payroll → Maintenance → Skip Calendars Editor
This is a very convenient option when an employee withholding for multiple employees should be set to skip (not be deducted on) certain pay periods. To review a detailed description, click the ‘Overview’ link under the FAQs menu when this area is open. Reminder: Only employee withholdings that are set to skip deductions under Payroll → Maintenance → Employees will be available to apply a skip calendar and additional employee-specific maintenance items may need to be updated before adding/applying skip calendars.

UPDATE EMPLOYEE-SPECIFIC MAINTENANCE ITEMS

**Payroll → Maintenance → Employees**
Checkmark Employee, Click Edit - Advanced

- **Employee Information**
  - Review contact information, Federal W-4 Form, Ohio IT-Form, State Retirement dates, etc. On the Employee Information tab, update settings and entries as needed.
  - Save and Close

- **EFT / Additional Information**
  - Electronic Funds Transfer (EFT) and additional information fields are optional (many UAN clients use EFT, but few use the additional information fields)
  - Click the EFT / Additional Info tab to review / update settings if needed.
  - Save and Close

- **Earnings - Edit**
  - Click the Earnings tab
  - Mark an earning and click Edit. In the edit form, you can change many settings such as the pay rate, appropriation accounts to charge, items attached to the earning, etc.
  - Click Save and Close

- **Earnings – Add New**
Payroll → Maintenance → Employees
Checkmark Employee, Click Edit - Advanced

- Click on the Earnings tab. Click Add to open an add form. Do not click save until you have completed all steps in the order below:
  - Complete the fields in the top sections before selecting the tabs in the lower half of the form.
  - Click the Withholdings tab and mark the withholdings that should be deducted from the earning.
  - Click the Accounts tab and select the split method and accounts that will be charged when paying the earning.
  - When necessary, complete the Details, Overtimes, and Non-Cash tabs.
- Click Save and Close

<table>
<thead>
<tr>
<th>Earnings – Deactivate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Earnings tab and mark an earning in the list.</td>
</tr>
<tr>
<td>Click Deactivate below the list. Then click Save and Close.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Overtimes - Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Overtime tab and mark an overtime. Click Edit to open an edit form.</td>
</tr>
<tr>
<td>Enter or adjust settings such as base pay rate, overtime rate, and accounts to charge or the earning in which the overtime is attached.</td>
</tr>
<tr>
<td>Click Save and Close</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Overtimes – Add New</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Overtime tab. Click Add to open an add form. Do not click save until you have completed all steps in the order below:</td>
</tr>
</tbody>
</table>
  - Complete the fields in the top sections before selecting the tabs in the lower half of the form. |
  - Confirm or revise the Overtime Rate in the Details tab. This will multiply times the Base Rate in the top section of the form. |
  - Click the Earnings tab and select to attach it one earning. |
  - Click the Withholdings tab to review the list of withholdings that will deduct when this overtime is paid (this is based on your earning selection) |
  - Click the Accounts tab and select the split method and accounts that will be charged when paying the overtime. |
| Click Save and Close |

<table>
<thead>
<tr>
<th>Deactivate Overtime</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Overtimes tab and mark an overtime in the list.</td>
</tr>
<tr>
<td>Click Deactivate below the list. Then click Save and Close.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Non-Cash Benefit – Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Non-Cash tab</td>
</tr>
</tbody>
</table>
# Payroll ➔ Maintenance ➔ Employees

## Checkmark Employee, Click Edit - Advanced

- Mark ✅ the Non-Cash Benefit and click Edit to open an edit form. Here you can edit the description, pay rate, and the ⭐ earning in which it is attached.
- Click Save and Close

## Non-Cash Benefit – Add New

- Click the Non-Cash tab. Click Add to open an add form.
- Select a Non-Cash Benefit item from the menu, confirm or revise the description, enter the pay rate select the ⭐ earning in which it should be attached.
- Click Save and Close

## Non-Cash Benefit – Deactivate

- Click the Non-Cash tab and mark an item in the list.
- Click Deactivate below the list. Then click Save and Close.

## Leave – Edit

- Click the Leaves tab
- Mark a leave and click Edit. In the edit form, you can change many settings such as the pay rate, leave accrual settings, and other settings applicable to entity policies.
- Click the Earning tab to review or change the marked ⭐ earnings that when paid, may accrue or use / pay the employee leave. Confirm the ⭐ ‘WH’ is set on the earning that determines which withholdings will be deducted when the leave is paid.
- Click the Accounts tab to change the split method or accounts that will pay this leave.
- Click Save and Close

## Leave – Add New

- Click the Leaves tab and click Add and an add leave form opens.
- Select a Leave from the menu, confirm or revise the description, enter the pay rate select ‘Paid when used’ for hourly or ‘Not paid when used’ for salaried.
- Do not click save until you have completed all steps in the order below:
  - Details tab-complete leave accrual settings, and other settings applicable to the entity leave policies.
  - Click the Earning tab and ⭐ mark earnings that when paid, may accrue or use / pay the employee leave. You must select an ⭐ earning in the ‘WH’ column that determines which withholdings will be deducted when the leave is paid.
  - Click the Withholdings tab to review the list of withholdings that will deduct when this leave is paid. If it is a blank list or incorrect, click the Earnings tab again to correct the ‘WH’ column setting and select ⭐ the correct earning.
  - Click the Appropriation Accounts tab to select the split method and accounts that will pay this leave.
- Click Save and Close
**Payroll → Maintenance → Employees**  
**Checkmark Employee, Click Edit - Advanced**

<table>
<thead>
<tr>
<th><strong>Leave – Deactivate</strong></th>
</tr>
</thead>
</table>
| • Click the Leaves tab and mark an item in the list.  
| • Click Deactivate below the list. Then click Save and Close.  

<table>
<thead>
<tr>
<th><strong>Withholdings – Edit</strong></th>
</tr>
</thead>
</table>
| • Click the Withholdings tab, and ✔ mark a withholding. Click Edit and an edit form opens.  
| • Details tab – review or change the rate or amount. If the withholding has an employer share distribution, review the applicable rates.  
| • Click the Earnings tab to confirm the earnings with a ✔ checkmark are those in which the withholding should be deducted when the earning (or attached items such as overtimes) is paid. Correct if necessary.  
| • Click the Appropriations Accounts (Employer Share) tab – if applicable. Confirm the split method and the appropriation accounts that will pay the employer share.  
| • Click the Appropriations Accounts (Fringe Benefits) tab – if applicable. Confirm the split method and the appropriation accounts that will pay the fringe benefit.  
| • Optional: click the Skip Deductions tab (only available for certain withholding types). Review the settings or read the on-screen instructions to complete the form. Note: the blue question mark 🤔 on this tab provides additional instructions about completing the tab correctly.  
| • Click Save and Close  

<table>
<thead>
<tr>
<th><strong>Withholdings – Add New</strong></th>
</tr>
</thead>
</table>
| • Click the Withholdings tab and click Add and a withholding form opens.  
| • Do not click save until you have completed all steps in the order below:  
  | o Select a withholding from the menu and confirm or revise the description.  
  | Note: you cannot have two withholdings with the same description.  
  | o Details tab – review or change the default rate or amount. If the withholding has an employer share distribution, review the applicable rates.  
  | o Click the Earnings tab to ✔ checkmark the earnings in which the withholding should be deducted when the earning (or attached items such as overtime) is paid.  
  | o If this withholding has an Employer Share Click on the Appropriations Accounts (Employer Share) tab and select the split method and appropriation accounts that will pay the employer share  
  | o If this is a withholding that has a fringe benefit option, click on the Fringe Benefits tab and select the split method and appropriation accounts that will pay the fringe benefit.  

Payroll → Maintenance → Employees
Checkmark Employee, Click Edit - Advanced

- Optional: click the Skip Deductions tab (only available for certain withholding types). Read the on-screen instructions to complete the form. Note: the blue question mark on this tab provides additional instructions about completing the tab correctly.
- Click Save and Close

This is a very convenient option when an employee withholding for multiple employees should be set to skip (not be deducted on) certain pay periods. To review a detailed description, click the ‘Overview’ link under the FAQs menu when this area is open. Reminder: Only employee withholdings that are set to skip deductions under Payroll → Maintenance → Employees will be available to apply a skip calendar and additional employee-specific maintenance items may need to be updated before adding/applying skip calendars.

- Withholdings – Deactivate
  - Click the Withholdings tab and mark an item in the list.
  - Click Deactivate below the list. Then click Save and Close.

EVALUATE LEAVE BALANCES

Caution! Leave balance adjustments in Temporary Mode: UAN recommends you post all final wages in the work year 2021 before making any leave balance adjustments in the work year 2022. Wages posted in 2021 may impact the amount you should adjust in 2022, so wait until all 2021 wages are posted before adjusting leave for the new year as required by your policy.

If you need to adjust leave balances in the new year, pay particular attention to the date you are paying wages, the pay period of the wages, and the date the leave changes are effective pursuant to your policy, and then adjust them at the proper time. UAN Menu: Payroll → Utilities → Leave Balance Adjustment. You will receive a message advising that you should retain supporting documentation for all leave balance adjustments; Audit will closely scrutinize them. Click OK.

On the Post Leave Balance Adjustment Form, you can select to adjust By Employee to adjust one employee at a time or select By Leave to adjust all employees with the same leave at once. Make adjustments as positive or negative numbers in the adjustment column. Enter the reason for the adjustment (e.g. 2022 Leave Granted; 2021 Unused leave lost per policy, etc.). Enter the effective date of the leave adjustment and click Post. You can print leave reports to verify correct balances: UAN Menu: Payroll → Reports & Statements → Leave Reports, select the desired report from the form menu, select the employees, and then click Print.
APPENDIX 6: YEAR END BALANCES CERTIFICATES

UAN provides a template for the ‘Certificate Of The Total Amount From All Sources Available For Expenditures, And Balances’, also referred to as the Year End Balances Certificate. The area for creating this is located in the Budget module:

**UAN Menu:** Budget → Transactions → Year End Balances Certificates

**IMPORTANT:** You should add the year end certificate *only after* posting *ALL* fiscal year 2021 transactions, utility adjustments, and the 12/31/2021 bank reconciliation. To add a year end balances certificate with balances as of 12/31/2021, log into UAN either by selecting Work Year ☀️ 2022 when Temporary Mode is open *OR* in 2022 after the fiscal year 2021 is closed. Go to Budget → Transactions → Year End Balances Certificates and confirm the default year - 2022 - is selected from the Year menu. Then click the Add button to open an Add Year End Balances Certificates form with “Balances as of 12/31/2021”.

**Note:** If you attempt to add the certificate while working in the fiscal year 2021 (with 2021 selected in the Year menu) the Add Year End Balances Certificates form will open, but it will pull in “Balances as of 12/31/2020”.

**ADD**

You must specify a certificate name when adding a year end balances certificate. All funds from the current and prior year display and all amounts are available to edit.

The Add form has two tabs: The Funds tab shows all funds and allows for edits to the data. The Display-Summary tab is read-only; displaying the data (*including edits*) from the Funds tab. The Display-Summary tab shows totals summed by fund type (*General, Special Revenue...etc.*) with totals for Governmental, Proprietary, and Fiduciary funds and a total for all funds.

**EDIT**

When there are edits to a certificate, any amounts saved to the worksheet that differs from the amounts calculated by UAN will list in a popup form ‘Update Year End Balances’. Optionally, any of the differing amounts on the certificate can be automatically updated to the amount calculated by UAN by selecting the amount on the pop-up form to import.

(See the Edit and Delete restrictions notes below).

**DELETE**

Use to delete year end balances certificates. (See Edit and Delete restrictions note below).
Edit and Delete Restrictions For Prior Years
Year end certificates that may have been added in previous years cannot be edited or deleted after closing the fiscal year. For example, any 2020 year end balances certificate that was added by the user while logged into 2021 (whether before or after opening Temporary Mode) will be unavailable to edit or delete after closing the fiscal year 2021.

PRINT / DISPLAY / SAVE PDF
A summary page will be produced along with a listing of all the funds on the certificate.

PRINT BLANK – located next to the add button
If needed, a blank copy of the certificate may be printed.

EXPLANATIONS OF COLUMN HEADINGS – YEAR END BALANCE CERT.

Note: The following information assumes a year end balances certificate is being added for balances as of 12/31/2021 while logged into UAN either by selecting Work Year ☀ 2022 when Temporary Mode is open OR in 2022 after the fiscal year 2021 is closed.

1. Cash Balances as of 12/31/2021

Definition: Cash balances per the cashbook of the governmental entity as of December 31.

Location in UAN: Prior year report, as of 12/31/2021
The ‘Fund Balance as of 12/31/2021’ on the Cash Summary by Fund. Menu path: Accounting ➔ Reports and Statements ➔ Fund Reports, select Cash Summary by Fund and select 2021 from the Year menu.

2. Reserved for Encumbrance as of 12/31/2021

Definition: All outstanding unliquidated encumbrances as of December 31, obligations in the form of purchase orders or contracts which were charged to a prior year’s appropriation and for which a part of that appropriation is reserved (carryover purchase orders and withholdings).

Location in UAN: Prior year report, as of 12/31/2021
The ‘Current Reserve for Encumbrance’ on the Fund Summary. Menu path: Accounting ➔ Reports and Statements ➔ Management Reports, select Fund Summary, and select 2021 from the Year menu.
3. **Reserved for Non-Spendable Balance as of 12/31/2021**

**Definition:** Reserve for funds that require non-expendable balances such as permanent funds and some private purpose trust funds. The non-expendable balances are set in Accounting ➔ Maintenance ➔ Funds.

**Location in UAN:** Prior year report, as of 12/31/2021

The ‘Reserved for Non-Spendable Balance 12/31’ column on the Resources Available for Appropriation. Menu path: Accounting ➔ Reports and Statements ➔ Budgetary Reports, select Resources Available for Appropriation and 2021 from the Year menu.

4. **Reserve Balance Accounts**

**Definition:** Reserve Balance Accounts as per sections 5705.13(A)(1) and/or 5705.132 of the Ohio Revised Code (ORC).

**Location in UAN:** Prior year report, as of 12/31/2021

The ‘Reserve Balance (5705.13(A)(1) & 5705.132) 12/31’ column on the Resources Available for Appropriation. Menu path: Accounting ➔ Reports and Statements ➔ Budgetary Reports, select Resources Available for Appropriation and 2021 from the Year menu.

5. **Advances Not Repaid**

**Definition:** Advances not repaid as of December 31---this amount should be added to the fund that made the advance and subtracted from the fund that will be making the reimbursement.

**Location in UAN:** Current year report, as of 1/1/2022

The ‘Prior Year Advances Not Repaid 12/31’ column on the Resources Available for Appropriation. Menu path: Accounting ➔ Reports and Statements ➔ Budgetary Reports, select Resources Available for Appropriation and 2022 from the Year menu.

6. **Carryover Balances Available for Appropriations**

**Calculation:** Columns 1 – 2 – 3 – 4 + 5 = Column 6

Cash Balance 12/31 (column #1) minus Reserved for Encumbrance 12/31 (column #2) minus Reserved for Non-Spendable Balance 12/31 (column #3) minus Reserve Balance Accounts (column #4) plus Advances not Repaid (column #5)
7. **Total Amount from All Sources Available for Expenditures**

**Definition:** The total amount from all sources the governmental unit expects to receive during the forthcoming fiscal year, which is available for expenditures.

**Location in UAN:** *Current year report, as of 1/1/2022*
Accounting → Reports & Statements → Revenue Reports, then select Revenue Budget and 2022 from the Year menu. Locate the amount for each fund sub-total in the Final Budget column. Note: The total per fund of each revenue budget should equal the tax revenue and other sources on the Certificate of Estimated Resources provided by the County Budget Commission.

8. **Total Amount Available plus Balances**

**Calculation:** Columns 6 + 7 = Column 8
Carryover Balance Available for Appropriations (column #6) plus Total Amount from all Sources Available for Expenditures (column #7)
APPENDIX 7: OCBOA STATEMENT PREPARATION

OVERVIEW
OCBOA Statement instructions begin with fund mapping, then Fund Classifications (GASB 54), followed by OCBOA (GASB 34) requirements. As noted previously, UAN provides software-use details, but can only provide minimal guidance on the nature of the entries and cannot address specific non-software questions. If you need further guidance about mapping, GASB 54, or OCBOA choices, please contact Local Government Services at ContactLGS@ohioauditor.gov or 800-345-2519. Again, UAN cannot suggest which items you should select or enter in this utility.

Prerequisite: Make Sure Fund Names Are Descriptive:
OCBOA statements do not include fund numbers, so it is especially important that fund names are descriptive of the fund's purpose and not the system defaults. For example, you should not name an enterprise fund ‘Enterprise’ or other miscellaneous capital fund as ‘Other Misc Capital’, etc. To edit fund names, go to the UAN Menu: Accounting → Maintenance → Funds, and then click ‘Need Help’ for more information.

Upon completing all OCBOA statement preparation below that applies to your entity, turn to page 17 to continue onto Step 4D - Entity & Fiscal Officer.

AFR - FUND UTILITY

UAN Menu: General → Reports & Statements → Year End → AFR – Fund Utility

All funds – whether active or inactive – will be on the list. Checkmark the funds you would like to edit and click Edit.

Click OCBOA and the ‘Edit AFR – Fund Utility’ form will open. When editing multiple funds at the same time, use the navigation arrows in the bottom left corner of the form.

For example, six funds were selected here: . Click the arrows to advance back and forth between funds or move to the first or the last fund selected.
When a fund is ‘mapped to’ another fund, it means the current fund’s balance will be considered part of the selected fund’s balance for the purpose of annual financial statements. Mapping is an option for miscategorized or ancillary (subsidiary) funds only. By default, funds are not mapped to other funds. Most UAN entities will have no need to map any of their funds. Clicking ‘Map To’ in the utility requires you to pick another fund that the current fund will be ‘mapped to’. When a fund is mapped to another fund:

- The cash balance of that fund will be included in the ‘Map To’ fund for the purpose of annual financial statements only.
- The mapped fund takes on all characteristics of the fund it is mapped to.
- If the characteristics of a fund that it is mapped to are changed, the mapped fund is updated to match.
- The mapping information will not carry over to the next year. The proper fund will need to be added once the entity is in the new year.
- You can map several funds to one fund, but a fund cannot be mapped to a fund that is also mapped to another fund.
- The General Fund is not allowed to be mapped to another fund.
- You cannot map Governmental or Proprietary type funds to Fiduciary type funds (Fiduciary to Fiduciary is permitted when applicable).

A typical example is if the fiscal officer determines money was miscategorized in 2021, but it will not be corrected until the beginning of 2022. Mapping will allow the fund to be categorized correctly for the purposes of the 2021 annual financial reports. After 2021 is closed, the balance of the fund should be moved to the fund to which it was mapped. Similarly, if this option is used to map a fund to a completely new fund, the original fund balance should be moved to the new fund after closing the year. Another example is the possibility that an Unclaimed Monies fund balance might need to be reported in the fund that will eventually receive the money (usually the General fund). This can be achieved by mapping.

For questions regarding whether or not a fund should be mapped to another, please contact Local Government Services at ContactLGS@ohioauditor.gov or 800-345-2519.

‘MAP TO’ STEPS
Mapping should only be done when necessary. To map a fund, click the ‘Map To’ button and select the fund number that the current fund’s balance will be considered part of for the purpose of annual financial statements. An example of fund mapping is in the image below:
Mapping Report:
If you map a fund in the AFR – Fund Utility, you can view the impact it has on the fund it is ‘mapped to’ with the Mapping report. **UAN Menu:** General -> Reports & Statements -> Year End -> AFR – OCBOA Statements, then select Mapping and the year from the menus.

### 2 - GOVERNMENTAL FUND CLASSIFICATION TAB

**GASB 54 Overview**
In February 2009, The Governmental Accounting Standards Board (GASB) released Statement 54, Fund Balance Reporting and Governmental Fund Type Definitions, to enhance uniformity and understanding of what constitutes ‘net’ fund balances and any restrictions placed on them. Paragraph 5 of the Statement reads:

“The statement establishes fund balance classifications that comprise a hierarchy based primarily on the extent to which the government is bound to honor constraints (restrictions or limitations) on the specific purposes for which amounts in the fund can be spent. Fund balance amounts are to be classified according to GASB 54 requirements and can be classified in one of five components: **Non-Spendable, Restricted, Committed, Assigned and Unassigned.**”

UAN can provide technical guidance for using the AFR – Fund Utility, but cannot provide advice about which classifications to apply. For guidance regarding GASB 54 fund classifications, please read the AOS Bulletin 2011-004 (issued September 29, 2011). In addition, Local Government Services has provided UAN with a Fund Purposes guide. For your convenience, both of these are accessible from the UAN webpage: [https://uanlink.ohioauditor.gov/training/yearend/default.html](https://uanlink.ohioauditor.gov/training/yearend/default.html)

If you have **any** questions about fund classifications after reading these documents, please contact Local Government Services at ContactLGS@ohioauditor.gov or 800-345-2519. UAN Support **cannot** answer such questions.
Disclosures: if disclosures are required to explain your entity’s classification policies and procedures, add them into UAN using the AFR - Notes & Documents area described on page 50.

**USING THE FUND CLASSIFICATION TAB:**

The governmental fund classification tab is only available and required for Governmental funds: General, Special Revenue, Debt Service, Capital Projects, and Permanent

If you completed the AFR – Fund Utility last year, any governmental fund classifications and purposes of funds for which you selected a **SINGLE** fund classification and purpose will carry forward into the 2021 Governmental Fund Classification screen. However, any fund classifications and purposes of funds for which you selected **MULTIPLE** classifications and/or purposes will NOT carry forward with their cash balances distributed in the 2021 Governmental Fund Classification screen. The reason for this is that fund classifications apply to ending fund balances, not to the funds themselves. In other words, as ending fund balances change from year to year, any funds with multiple classifications must be redistributed (i.e. reclassified) accordingly.

At least one classification should be assigned to the fund balance and a purpose must be stated for the balance (in the ‘For’ field). If the entire fund cash balance will fall under one classification, then click ‘Single’. If the fund cash balance is split between several classifications, then click ‘Multiple’. See the examples below:

**Single:**

Click the menu to the right to select the classification. **Example 1a:**

**Multiple:**

Click the menu to the right to select the classification. **Example 1a:**
Then in the ‘For’ field, either click the menu to select an existing purpose or type a new one directly into the field. Click Save.

Example 1b:

The classifications labeled ‘Default’ in the Classification menu are those identified by LGS as the most likely classifications based on the use of the resources/revenues. Some funds may have several defaults depending on the range of possibilities for the particular fund. The pre-set purpose options listed in the ‘For’ menu were provided by LGS as typical, and those labeled ‘Default’ were identified as the most likely. However, you may type in a different purpose as needed. Note: The application will add any custom purposes to the menu so that they are available to pick quickly for other funds when applicable.

✏ Multiple:
If you select multiple, the ‘Undistributed’ field lists the fund balance. In the Classification list below, click the menu in the data entry line and select the classification type for the first cash amount to be classified. Then under the ‘For’ column, click the menu in the data entry line to select an existing purpose or type a new one directly into the field. Next, enter the amount to be classified. Click the insert row arrow to push that line up to the list. Continue the steps above until the fund cash balance is fully distributed and then click Save. Repeat for all governmental fund types.

The fund in the example below has a fund balance of $5,310.22 and so far $5,000.00 has been classified. The remaining $310.22 undistributed balance must be classified.
Example 2:

Note: if any cash transactions post after completing the AFR-Fund Utility, the sections applicable to those transactions may change to an incomplete status in the Year End Checklist.

3 - OCBOA – FUND INFORMATION TAB

FUND RESTRICTION

For OCBOA reporting, each fund’s balance must be designated either restricted or unrestricted. If the fund balance or a portion of the fund balance is restricted, then it must be further designated as capital, debt, or other type of restriction. UAN will display a default restriction type based on how the fund type is normally defined by Local Government Services, but this can be changed based on the entity’s specific use of the fund.

Note: If you completed the AFR – Fund Utility last year, any restriction selections of funds for which you selected a SINGLE restriction type have been carried forward to the 2021 OCBOA – Fund Information screen.

However, any restriction selections of funds for which you selected MULTIPLE restriction types will NOT carry forward to the 2021 OCBOA – Fund Information screen. This is because restriction types apply to ending fund balances, not to the funds themselves. In other words, as ending fund balances change from year to year, any funds with multiple restriction types must be redistributed accordingly each year.

**Continue to the next page**
Single:
Select this button when the entire fund balance should be designated as unrestricted or restricted (capital, debt, or other). Then click the menu to the right to select the type. The default type will list on the menu.

Multiple:
Select this button if the fund balance is split between several types. The calculated column will include the fund balance in the default type. Enter amounts in the override column to distribute the fund balance between the different types until the total fund balance in the calculated and override columns are equal.

FAQ: When should a fund balance be designated restricted vs. unrestricted?

Funds should be designated as restricted when constraints placed on the assets use are either imposed through external creditors or imposed by law through constitutional provisions or enabling legislation. Funds should be designated as unrestricted when they do not meet the criteria of a restricted fund. If you need further guidance, please contact Local Government Services at ContactLGS@ohioauditor.gov or 800-345-2519.

Exceptions:
Investment Trust Funds
Automatically marked as ‘Restricted other’.

Permanent and Private Purpose Funds
Automatically restricted and with the requirement to distribute the fund balance into non-expendable and expendable portions. To confirm or override the calculated amounts, enter the non-expendable and expendable amounts in the override column. The Total Fund Balance in the override column must equal the amount in the calculated column.

Note: The non-expendable amounts in the calculated column for Permanent & Private-Purpose Trust funds are pulled from information entered in Accounting. Changing amounts in the override column will only update OCBOA reports; it will not change the fund information in the software. To change the non-expendable balance in the funds, follow the steps below:

UAN Menu: Accounting → Maintenance → Funds. checkmark the fund and click Edit. Type in the non-expendable amount of the fund in the ‘Non-Exp. Balance’ field and click Save.
FUND DETAILS

Governmental and enterprise funds must be marked as major or non-major for OCBOA financial statements. On several of the OCBOA statements, the funds marked as major will be displayed in individual columns, while the non-major funds will be combined into an ‘other funds’ column.

Major Fund: Yes, or No?
First, note the system default in the calculated column. You must confirm or change the setting by clicking the menu in the override column and selecting either Yes (it is a major fund) or No (it is not a major fund). The general fund is the exception – it will always be marked as a major fund and you cannot change the setting. Note that you do not need to designate fiduciary funds and internal service funds as major or non-major, as they report separately.

FAQ 1: How do I determine whether a fund is a major fund?
The default for the fund (the Yes or No in the calculated column) is computed from the fund information and activity inputted throughout the year (see FAQ 2 below). In some cases, you might choose to override the default if you have information that is classified incorrectly and/or not reflected in the software. A fund can also be marked as major if government officials believe it is an important fund even though the calculation identifies it as non-major.

FAQ 2: How does UAN calculate the default?
The Major Fund Analysis report illustrates the calculation. Print the report and then review the definition in the paragraph that follows.

UAN Menu: General ➔ Reports & Statements ➔ Year End ➔ AFR – OCBOA Statements, then select Major Fund Analysis and the system year.

A fund is considered major if any element of the fund (receipts, disbursements, or assets) comprise 10 percent or more of that element’s total for all funds of the fund’s type (either governmental or enterprise), and the same element also comprises 5 percent or more of that element’s total for all governmental and enterprise funds combined. The same element must meet both the 10 percent and 5 percent criteria.

FUND ASSETS
This section displays fund assets in terms of how cash & cash equivalents and non-pooled investments are separated for OCBOA statements. The UAN system separates fund assets into two general categories: Equity in Pooled Cash and Cash Equivalents and Investments (non-pooled). Most funds will only consist of these two categories of fund assets. The amounts are calculated based on your transaction and utility input in the normal course of the year and can be easily viewed on the Fund Status report located in Accounting ➔ Maintenance ➔ Fund Reports.
Review to confirm that this is an accurate breakdown of the entity’s fund balance and if needed, make corrections in Accounting. For example, perhaps interest earned on a non-pooled investment was supposed to be reinvested but was posted to the checking account in error. This error would inflate the Equity in Pooled Cash & Cash Equivalents and deflate the Investments (non-pooled) balance and can be corrected with Accounting transactions or utilities.

OCBOA statements may break down fund assets with two additional categories:

- Cash and Cash Equivalents in Segregated Accounts
  - Example: Mayor’s court at a village – which is kept in a separate account

- Cash and Cash Equivalents with Fiscal/Escrow Agents
  - Example: Monies held and then distributed by another entity on behalf of your entity, such as the county.

Note: Most funds will not have balances made up of these two categories and many UAN entities do not have any funds that consist of these. However, when applicable, entering amounts in either of the above categories will automatically reduce (distribute) the balance of the fund’s Equity in Pooled Cash and Cash Equivalents for OCBOA purposes.

Custodial Funds: You must identify whether custodial funds should report the categories in this section as part of an External Investment Pool or Other Custodial on the Statement of Fiduciary Net Position and the Statement of Changes in Fiduciary Net Position.

FUND PURPOSE

Permanent fund types must have a purpose assigned for OCBOA financial statements. Type a purpose for the fund directly into the Fund Purpose field/drop-down menu.

Note: The application will add the description you entered to the menu so that it is available to pick quickly for other funds (when applicable).
OVERVIEW

You must classify revenues as either program or general receipts for the Statement of Activities report for all governmental and proprietary funds:

- General
- Special Revenue
- Debt Service
- Capital Projects
- Permanent
- Enterprise
- Internal Service

Note: If you completed AFR – Fund Utility for OCBOA before closing last year, then the program/general receipt type and revenue type selections for the funds you had last year have been carried forward to the 2021 OCBOA – Revenue Programs screen.

Program Receipts

Revenues are to be classified as program receipts if they come from:

- Purchasers, users, or direct beneficiaries of the goods or services of the entity’s programs
- Parties outside the reporting government’s citizenry if the revenue is restricted to a specific program

If classified as program receipts, revenues must be further separated into revenue types:

1. Charges for services and sales
2. Operating grants/contributions
3. Capital grants/contributions

General Receipts

All revenues are classified as general receipts unless they are required to be reported as program receipts. Put specifically, revenues are classified as general receipts if they come from:

- Parties outside the reporting government’s citizenry if the revenue is unrestricted
- The reporting government’s taxpayers
- The governmental institution itself

The decision diagram that follows illustrates possible classifications for each account code:
It will be helpful to view a draft of the Statement of Activities before using the utility. The list of receipt types is taken directly from this report and the Chart of Accounts.

**UAN Menu:** General → Reports & Statements → Year End → AFR – OCBOA Statements, then select the system year and Activities statement.

For questions concerning these classifications, please contact Local Government Services at ContactLGS@ohioauditor.gov or 800-345-2519.

**USING THE UTILITY**

The revenue list will include all revenue accounts in the fund – both active and inactive codes. You can skip revenue codes with a zero Amount Received balance. The application will automatically assign a default classification for most revenues. When a default is selected it will be highlighted in blue font. The defaults may not be correct for every entity, so you should review and make corrections when necessary. Then assign the proper classification for revenues that do not have an automatic default (if any).

**Program / General Receipt Type**
To assign or change, hover the mouse pointer over the field until an arrow appears and click to view the list of options.

**Revenue Type**
It is best to pick the program or general receipt type first before completing this field to avoid inadvertently resetting the revenue type. To assign or change, hover the mouse pointer over the field until an arrow appears and click to view the list of options.
Fiduciary funds include any custodial, private-purpose trust, and investment trust funds. Assign one or more of the classifications on this form to the total of each account code. You can skip accounts that have no dollar amount to distribute.

**Revenue Account List**
You must classify the total receipts of each revenue account by selecting one of the options from the Receipts menu:
- Property and Other Local Taxes Collected for Distribution
- Charges for Services
- Fines, Licenses and Permits for Distribution
- Earnings on Investments
- Intergovernmental
- Special Assessment Collections for Distribution
- Performance Deposits Received
- Amounts Held for Employees
- Amounts Received as Fiscal Agent
- Other Amounts Collected for Distribution
- Multiple – Selecting will display all of the classifications in rows below the revenue account with entry fields to distribute the account total to more than one classification.

**Appropriation Account List**
You must classify the total disbursements of each appropriation account by selecting one of the options from the Disbursements menu:
- Distributions as Fiscal Agent
- Distributions to Other Governments
- Distributions of Performance Deposits
- Distributions on Behalf of Employees
- Other Distributions—Cemetery Beneficiaries
- Other Distributions—Scholarship Beneficiaries
- Other Distributions
- Multiple – Selecting will display all of the classifications in rows below the appropriation account with entry fields to distribute the account total to more than one classification.
Currently, very few entities on UAN use internal service funds. Information about internal service funds is available under **UAN Menu: Accounting → Maintenance → Funds**, then click ‘Need Help’ and scroll to FAQ #10.

This tab enables you to associate receipts in the Internal Service Fund to their related expenditures in other governmental funds. Doing so will eliminate double-posting to minimize the grossing up effect on the OCBOA government-wide statements (Statement of Activities). The reduction of receipts in the internal service fund must equal the reduction in expenditures in other governmental funds. Reductions are input using the following grid lists:

**Governmental Activity list**
This grid will list the disbursements for all funds for the year grouped by appropriation programs. The disbursements column is read-only. Expenditures are reduced by entering positive amount(s) in the Adjustment column for the relevant program expenses.

**Revenue Account list**
This grid will list all of the revenue accounts in the internal service fund. The receipts column is read-only. Receipts are reduced in the internal service fund by entering positive amount(s) in the Adjustment column for the relevant revenue accounts.
Component units usually maintain their own financial information and are generally audited separately from the primary government. UAN entities VERY RARELY have component units. If you are unfamiliar with component units, it is unlikely that it applies to your entity and you can probably skip this step. Before adding a component unit here, contact the State Auditor’s Local Government Services division at ContactLGS@ohioauditor.gov or 800-345-2519 so that they can review the documentation for creating a potential Component Unit.

Any component unit must be a legally separate organization with 1) its own legal name, 2) the ability to sue or be sued in its name, and 3) the ability to hold property in its name, with some type of ongoing financial accountability to the primary government entity. GASB Statement 39 and Auditor of State Bulletin 2004-001 both address issues related to component units in detail. You can access the AOS bulletin online by typing this address into your web browser:


The AFR – Component Unit utility provides you with a way to add these to your OCBOA statements.

UAN Menu: General → Reports & Statements → Year End → AFR – Component Units, then click Add to open the form.

Enter the Name of the component unit and complete the form. The information should come from the annual financial report of the affiliated organization. Note: the amounts must be entered in whole dollar figures i.e. you cannot enter cents. This information is used in the Statement of Net Position and the Statement of Activities reports.
Follow these steps if for any reason you need to re-create the 2021 AFR-AOS Backup (Year End Backup 3 of 3) after the fiscal year has closed or for any previous fiscal year that the entity submitted the AFR through UAN. For example, you might need to do this if you close the year successfully – which occurs after the Year End (Backup 1 of 3) completes, but accidentally cancel the AFR-AOS (Backup 3 of 3) before it completes successfully.

**IMPORTANT**: Resubmitting your AFR – AOS Backup will update your annual financial report filing date with the Hinkle System. This resubmission date must still fall within the legal deadline for submitting your AFR for the year - financial penalties may be assessed for late filings. Each local government is required to submit their Annual Financial Report to the Auditor of State within **sixty (60) days of the end of the fiscal year**. Meeting this requirement for UAN members occurs when UAN receives the 2021 AFR – AOS backup internet (or disc) submission containing the end of year filing data of the government.

**UAN Menu**: General → Maintenance → Year End → AFR – Re-Create AOS Backup. Read the message carefully and click OK.

You must choose a backup destination, either Internet Submission (instructions start on page 122) or Postal Submission (instructions start on page 124). UAN recommends internet submission for entities that have access to a good high-speed internet connection.
INTERNET SUBMISSION (RE-CREATE AFR-AOS BACKUP)

Make sure the computer has an internet connection and follow the ‘UAN Menu:' on page 121 after reading the important information on that page. When the AFR-Re-create AOS Backup form opens:

Select ‘互联网 Submission – Active Connection Required.’
Click Start

An AFR-Re-create AOS Backup Options form with open; it will list all the years that your entity closed the fiscal year using UAN. Read the form carefully.

- Do not change the default Purpose:
  ‘互联网 Re-submitting years selected below to Hinkle System’.

- Checkmark ☑ the year(s) that you will resubmit.

- Checkmark ☑ the acknowledgment statement when you are ready to certify the accuracy and completeness of the AFR submission and the entity’s responsibilities. ‘☑ I affirm …’

- Click Save. The options form will close and the backup form will begin the process. After it prepares the backup for upload, a file-submission progress message will open as follows:

![Progress]

Submitting file to AOS... Please wait

UAN will automatically upload the file to the AOS Hinkle System i.e. there is no need to login to a website or search for a file for upload. Please be patient. The amount of time it will take to upload the file can vary significantly depending on your internet speed and the size of the file. Entities with high-speed internet service can expect uploading the file to take 1-5 minutes for a file under 50MB, 5-10 minutes for 50-100MB files, or 10-30 minutes for files over 100MB. For entities that use the very slow ‘dial-up’ internet (i.e. not a high-speed internet service), UAN recommends mailing the file on a disc (see page 124 if needed).

Please note: When you browse websites, you are “downloading” information, but when you transmit a file off the computer to AOS, you are “uploading” information. Internet upload speeds
are typically 1/10th as fast as download speeds, so even though you may have a “high-speed internet” service that does not necessarily mean you have “high-speed uploads” as well.

When the upload is complete, the following message will open:

![System Message](image)

Carefully read the message and click OK.

Note: If the backup fails to upload, a status message will appear in the backup form “Backup Failed. Please try again or contact UAN for assistance.” Confirm or establish an internet connection and click Start to try again. If the upload continues to fail, you can either change the type to ‘Postal Submission’ to create a disc for mailing or close the form and try again after establishing a good internet connection.

Be sure to read “Meeting Annual Reporting Requirements for the Auditor of State” starting on page 35 concerning the deadline requirements and steps to confirm the status of your submission.
POSTAL SUBMISSION (AFR RE-CREATE AOS BACKUP)

If the UAN computer is a laptop, connect the external CD/DVD drive and insert a blank disc in the CD/DVD tray. The computer may automatically open a File Explorer window – please close the window. Alternatively, the computer might prompt you with a message to choose what to do with the disc drive – similar to the message below.

If there is an option to cancel, then select it. Otherwise, you may choose either ‘take no action’ or ‘open the folder to view files’ and then close the folder immediately.

Follow the ‘UAN Menu:’ on page 121 after reading the important information on that page. When the AFR-Re-create AOS Backup form opens:

Select ‘Postal Submission – CD or DVD’.

If needed, click ‘Browse’ to open a ‘DriveSelect’ form that lists the current disc drive letter that Windows has assigned to the disc drive. Select the drive and click OK to close the DriveSelect form.

Click Start.

An AFR-Re-create AOS Backup Options form will open; it will list all the years that your entity closed the fiscal year using UAN. Read the form carefully.

- Do not change the default Purpose:
  ‘Re-submitting years selected below to Hinkle System’.

- Checkmark the year(s) that you will resubmit.

- Checkmark the acknowledgment statement when you are ready to certify the accuracy and completeness of the AFR submission and the entity’s responsibilities. ‘I affirm …’

- Click Save. The options form will close and the backup form will begin the process. After it prepares the backup for writing, a disc writing progress message will open as follows:
When it finishes, the following message will open and the disc will eject:

![System Message]

Immediately label the AFR – AOS Backup disc for audit submission as follows:

**2021 AFR**
Your Entity Name
Your County Name
Your UAN Entity ID 4-digit Number

Please mail the disc to:

Auditor of State of Ohio  
Uniform Accounting Network  
88 E. Broad St.  
Columbus, Ohio 43215

Be sure to read “Meeting Annual Reporting Requirements for the Auditor of State” starting on page 35 concerning the deadline requirements and steps to confirm the status of your submission.